# Table of Contents

Introduction ................................................................................................................................. 1
Objective .......................................................................................................................................... 1
Getting Started .............................................................................................................................. 1
   Software Requirements ................................................................................................................. 1
   Setting up the Arc Hydro Tools .................................................................................................. 1
   Installing Arc Hydro and the Water Utilities Application Framework ..................................... 4
   Loading the Arc Hydro tools in ArcMap ....................................................................................... 8
   Setting Default Vector Target Location Type ............................................................................. 10
   Default temporary workspace used by the tools .......................................................................... 12
   Dataset Setup ............................................................................................................................ 12
   Important Considerations before starting a new Arc Hydro Project ......................................... 12
   Tutorial Data ................................................................................................................................ 13

Terrain Preprocessing ................................................................................................................ 16

DEM Manipulation ...................................................................................................................... 17
   1. Level DEM ............................................................................................................................... 17
   2. DEM Reconditioning ............................................................................................................... 19
   3. Assign Stream Slope .............................................................................................................. 20
   4. Burn Stream Slope .................................................................................................................. 22
   5. Build Walls ............................................................................................................................. 23
   6. Sink Prescreening ................................................................................................................... 25
   7. Sink Evaluation ...................................................................................................................... 26
   8. Depression Evaluation ........................................................................................................... 28
   9. Sink Selection ......................................................................................................................... 30
   10. Fill Sinks ............................................................................................................................. 32

Terrain Processing ..................................................................................................................... 34
   1. Flow Direction ......................................................................................................................... 34
   2. Flow Direction with Sinks ...................................................................................................... 35
   3. Adjust Flow Direction in Lakes ............................................................................................. 36
   4. Flow Accumulation ................................................................................................................ 37
   5. Stream Definition ................................................................................................................... 38
   6. Stream Segmentation ............................................................................................................. 39
   7. Flow Direction with Streams ............................................................................................... 39
   8. Combine Stream Link and Sink Link ..................................................................................... 42
   9. Catchment Grid Delineation ................................................................................................. 44
   10. Catchment Polygon Processing ........................................................................................... 44
   11. Drainage Line Processing ................................................................................................... 44
   12. Adjoint Catchment Processing ........................................................................................... 47
   13. Drainage Point Processing .................................................................................................. 49
   14. Longest Flow Path for Catchments ...................................................................................... 51
   15. Longest Flow Path for Adjoint Catchments ......................................................................... 52

Other Functions ........................................................................................................................ 53
   1. Slope ...................................................................................................................................... 53

Watershed Processing ................................................................................................................. 54

Delineation Functions ................................................................................................................. 54
   1. Batch Watershed Delineation ................................................................................................. 54
   2. Batch Subwatershed Delineation ........................................................................................... 59
   3. Batch Global Watershed Delineation ..................................................................................... 61
4. Batch Watershed Delineation for Polygons .................................................................61
5. Delineate from Multiple Inlets and Outlets .................................................................65

Watershed Characterization Functions ..................................................................................69
1. Drainage Area Centroid .................................................................................................69
2. Longest Flow Path ..........................................................................................................70
3. Longest Flow Path for Watersheds ................................................................................72
4. Longest Flow Path for Subwatersheds ..........................................................................73
5. Main Flow Path ................................................................................................................74
6. Construct 3D Line ..........................................................................................................78
7. Smooth 3D Line .............................................................................................................79
8. Flow Path Parameters from 2D Line .............................................................................81
9. Flow Path Parameters from 3D Line .............................................................................82
10. Basin Length ................................................................................................................84

Network Tools .......................................................................................................................87
1. Hydro Network Generation ............................................................................................87
2. Node/Link Schema Generation ......................................................................................90
3. Store Flow Direction ......................................................................................................92
4. Set Flow Direction ..........................................................................................................93

Attribute Tools ......................................................................................................................94
1. Assign HydroID ..............................................................................................................94
2. Generate From/To Node for Lines ...............................................................................96
3. Find Next Downstream Line ..........................................................................................97
4. Populate DrainArea for Drainage Line .........................................................................99
5. Calculate Length Downstream for Edges ..................................................................99
6. Calculate Length Downstream for Junctions ...............................................................100
7. Find Next Downstream Junction ..................................................................................101
8. Store Area Outlets – Junction Intersect Method .........................................................103
9. Store Area Outlets – Drainage Point Proximity Method .............................................105
10. Store Area Outlets – Next Downstream Area Method ...............................................106
11. Consolidate Attributes ................................................................................................107
12. Accumulate Attributes ................................................................................................110
13. Compute Local Parameters .......................................................................................113
14. Compute Global Parameters .......................................................................................115
15. Compute Point Parameters ..........................................................................................116
16. Generate Report ..........................................................................................................117
17. Export Data ..................................................................................................................120

Time Series Functions ...........................................................................................................122
1. Display Time Series .....................................................................................................122
2. Transfer ID ....................................................................................................................127
3. Transfer Value ..............................................................................................................129
5. Scale Design SCurve .....................................................................................................130
6. Accumulate SCurve ......................................................................................................133
7. Export SCurve to RAI ..................................................................................................135

Buttons and Tools ...............................................................................................................137
1. Flow Path Tracing ..........................................................................................................137
2. Interactive Flow Path Tracing ......................................................................................137
3. Point Delineation ...........................................................................................................139
4. Delineate using EPA Web Service ..............................................................................142
5. Batch Point Generation ...............................................................................................143
6. Assign Related Identifier ............................................................................................145
7. Global Point Delineation ........................................................................................................... 146
8. Trace By NextDownID Attribute ............................................................................................. 146
9. Main Flow Path Tracing ............................................................................................................. 147
Terrain Morphology ....................................................................................................................... 149
1. Drainage Area Characterization ............................................................................................... 152
2. Drainage Boundary Definition .................................................................................................. 156
3. Drainage Boundary Characterization ....................................................................................... 159
4. Drainage Connectivity Characterization .................................................................................. 163
Global Functions ............................................................................................................................ 169
1. Global Point Delineation ............................................................................................................ 169
2. Batch Global Watershed Delineation ....................................................................................... 178
3. Compute Global Parameters ....................................................................................................... 180
Introduction

The purpose of this tutorial is to illustrate, step-by-step, how to install Arc Hydro and use the major functionality available in the tools. This is a hands-on document focusing on how, not why. There is little discussion on implementation or internal operation of a tool. This document is targeted to an experienced water resources ArcGIS user who wants to learn how to use the tools. The online help provides more detail on the way the tools operate.

Objective

In this tutorial, the user will perform drainage analysis on a terrain model. The Arc Hydro tools are used to derive several data sets that collectively describe the drainage patterns of a catchment. Raster analysis is performed to generate data on flow direction, flow accumulation, stream definition, stream segmentation, and watershed delineation. These data are then used to develop a vector representation of catchments and drainage lines. Using this information, a geometric network is constructed. Utility of Arc Hydro tools is demonstrated by applying them to develop attributes that can be useful in hydrologic modeling. To accomplish these objectives, the user is exposed to important features and functionality of Arc Hydro tools, both in raster and vector environment.

Getting Started

Software Requirements

- .Net Framework 3.5 for ArcGIS 10
- ArcGIS 10 (Note: Arc Hydro is fully functional for ArcInfo and ArcEditor only – limited functionality is available with ArcView – see note below).
- Spatial Analyst extension
- Water Utilities Application Framework (ApFramework): now automatically installed with Arc Hydro

Note: Using Arc Hydro with ArcView

The Arc Hydro tools version 2.0 require ArcInfo/ArcEditor 10 with the Spatial Analyst extension. Since ArcView allows only limited editing (simple features), not all functions are available with ArcView. In particular, the following functions require ArcInfo/ArcEditor:
- Hydro Network Generation
- Calculate Length Downstream for Edges
- Calculate Downstream for Junctions
- Find Next Downstream Junctions
- Store Flow Direction
- Set Flow Direction
- Drainage Boundary Definition

The following tables summarize the requirements (ArcEditor/ArcInfo and Spatial Analyst) for each function in Arc Hydro.

<table>
<thead>
<tr>
<th><strong>Terrain Preprocessing</strong></th>
<th><strong>Requires ArcInfo/ArcEditor</strong></th>
<th><strong>Requires Spatial Analyst</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Level DEM</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>DEM Reconditioning</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Assign Stream Slope</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Burn Stream Slope</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Build Walls</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Sink Prescreening</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Sink Evaluation</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Depression Evaluation</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Sink Selection</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill Sinks</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Flow Direction</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Flow Direction with Sinks</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Adjust Flow Direction in Lakes</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Flow Accumulation</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Stream Definition</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Stream Segmentation</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Flow Direction with Streams</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Combine Stream Link and Sink Link</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Catchment Grid Delineation</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Catchment Polygon Processing</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Drainage Line Processing</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Adjoint Catchment Processing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Drainage Point Processing</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Longest Flow Path for Catchments</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Longest Flow Path for Adjoint Catchments</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Slope</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Terrain Morphology</strong></th>
<th><strong>Requires ArcInfo/ArcEditor</strong></th>
<th><strong>Requires Spatial Analyst</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Drainage Area Characterization</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Drainage Boundary Definition</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Drainage Boundary Characterization</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Drainage Connectivity Characterization</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Watershed Processing</strong></th>
<th><strong>Requires ArcInfo/ArcEditor</strong></th>
<th><strong>Requires Spatial Analyst</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch Watershed Delineation</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Batch Subwatershed Delineation</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Batch Global Watershed Delineation</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Batch Watershed Delineation for Polygons</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
### Attribute Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Requires ArcInfo/ArcEditor</th>
<th>Requires Spatial Analyst</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign HydroID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generate From/To Node for Lines</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Find Next Downstream Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Populate DrainArea for Drainage Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calculate Length Downstream for Edges</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Calculate Length Downstream for Junctions</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Find Next Downstream Junction</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Store Area Outlets – Junction Intersect Method</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Store Area Outlets – Drainage Point Proximity Method</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Store Area Outlets – Next Downstream Area Method</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consolidate Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accumulate Attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display Time Series</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transfer ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transfer Value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale Design SCurve</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accumulate SCurve</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export SCurve to RAI</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compute Local Parameters</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Compute Global Parameters</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Compute Point Parameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generate Report</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export Data</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Network Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Requires ArcInfo/ArcEditor</th>
<th>Requires Spatial Analyst</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydro Network Generation</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Node/Link Schema Generation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Store Flow Direction</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Set Flow Direction</td>
<td>x</td>
<td></td>
</tr>
</tbody>
</table>
**Buttons and Tools** | Requires ArcInfo/ArcEditor | Requires Spatial Analyst
---|---|---
Flow Path Tracing | | x
Interactive Flow Path Tracing | x |
Point Delineation | x |
Batch Point Generation | |
Assign Related Identifier | |
Global Point Delineation | x |
Trace By NextDownID Attribute | |
Main Flow Path Tracing | |

**Setting up the Arc Hydro Tools**

As indicated in the software requirements, the Arc Hydro tools version 2.0 require Microsoft .Net Framework 3.5, ArcGIS 10, the Spatial Analyst extension, and the Water Utilities Application Framework (ApFramework).

**Installing Arc Hydro and the Water Utilities Application Framework**

- Double-click the Arc Hydro installation package, ArcHydroTools.msi.

- Click Next.
- Check the radio button to accept the license agreement and click Next.

- Specify the desired installation location and click Next.
Click Install to start the installation process. You will see the following processing window.

The tool will display the following window when the installation is completed.
- Click Finish once the install is completed.

**Note**

Arc Hydro is installed on top of the Water Utilities Application Framework (ApFramework):

- The framework is automatically installed by the Arc Hydro installation package if it is not already installed. The user will not be prompted. The Water Utilities Framework is not displayed in the list of installed programs (it is only listed if installed separately).

- If the Arc Hydro tools are the only tools using the Water Utilities Application Framework, the framework will be uninstalled with Arc Hydro. If another application is using the Framework, it will not be uninstalled with the Arc Hydro tools.

- When installing Arc Hydro, the installation package checks whether the framework is already installed. If it is, it checks the version installed against the version required by Arc Hydro. If the installed version is an earlier version, the installation package automatically upgrades the version of ApFramework without prompting the user.

**Note**

If you are still getting a message stating that a different version of ApFramework is already installed after uninstalling all the applications that may be using it (HEC-GeoRAS, HEC-GeoHMS, Arc Hydro Tools), you may have to manually delete the installation key in your registry through the following steps:

- Click Start and type regedit in the Run window. Browse to either of the following keys: HKEY_LOCAL_MACHINE\SOFTWARE\ESRI\Applications\WaterUtilities\ApFrameworkMM or HKEY_LOCAL_MACHINE\SOFTWARE\ESRI\Applications\WaterUtilities\ApFramework
or
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ESRI\Applications\WaterUtilities\ApFramework

or
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ESRI\Applications\WaterUtilities\ApFramework

- Right-click this key and select Delete.

**Note**
If a previous version of the Arc Hydro tools is already installed, the setup will prompt you whether to repair, remove or modify the program.

**Note**
If you are still getting a message stating that the tools are already installed, but you do not see them in the Add/Remove Programs window and the Arc Hydro directory has been removed, you need to manually delete the Arc Hydro installation key in your registry as follows:

- Click Start and type regedit in the Run window. Browse to the key:
  HKEY_LOCAL_MACHINE\SOFTWARE\ESRI\Applications\WaterUtilities\ArcHydro
  or
  HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ESRI\Applications\WaterUtilities\ArcHydro

- Right-click this key and select Delete.

The Arc Hydro tools are installed by default under:
C:\Program Files (x86)\ESRI\WaterUtils\ArcHydro
or
C:\Program Files\ESRI\WaterUtils\ArcHydro.

The Water Utilities Framework is installed by default under:
C:\Program Files (x86)\ESRI\WaterUtils\ApFramework
or
C:\Program Files\ESRI\WaterUtils\ApFramework

### Loading the Arc Hydro tools in ArcMap

- Open a new empty map document in ArcMap.
- Right click on the menu bar to pop up the context menu showing available tools.

![Arc Hydro Tools](image)

The Arc Hydro Tools toolbar is shown below.
**Note**

It is not necessary to load the Spatial Analyst, Utility Network Analyst, or Editor tools because Arc Hydro Tools will automatically use their functionality on as needed basis. These toolbars need to be loaded though if you want to use any general functionality that they provide (such as general editing functionality or network tracing).

However, the Spatial Analyst Extension needs to be activated, by clicking Customize>Extensions…, and checking the box next to Spatial Analyst.

The Arc Hydro toolbox is also installed by the setup. Refer to the document Arc Hydro GP Tools 2.0 – Tutorial.pdf for more information on the geoprocessing tools available with Arc Hydro.
Setting Default Vector Target Location Type

In ArcGIS 10, if the map is not saved, the default locations are set to the user’s Windows temp directory for the raster and to the untitled.gdb filebased geodatabase in that directory for the vector location.

Note
These locations can be displayed by clicking ApUtilities > Set Target Locations and selecting the HydroConfig node.

- Click ApUtilities>Set Target Locations. Select HydroConfig and click OK.

The Set target locations window displays the default raster and vector locations.
The tools will use the locations above when the map is not saved or when the target locations have not been explicitly set using Set Target Locations for example.

When the map is saved, the Arc Hydro tools will use as default raster location the directory where the mxd is saved and as default vector location a geodatabase with the same name as the mxd located in the same directory. The tools will update the configuration with the new default locations. You will see the updated locations by using Set Target Locations but only after running one of the tools.

By default, in ArcGIS 10, Arc Hydro uses a filebased geodatabase as default vector location. The default setting may be changed to an Access geodatabase by editing the XML file associated with the Arc Hydro tools. They are 2 types of XML files that may be edited:

- ArcHydro\Bin\ArcHydroTools.xml: XML file physically stored on the computer. All new map documents will use this XML.
- XML file associated to the map document: edits to this file apply only to the corresponding map document. Note that the edit to switch the default vector location type must be done before using any of the Arc Hydro tools as the default location is set when using the first tool.

**Editing the XML on the disk**

- Browse to the ArcHydro\bin location (Defaults to C:\Program Files\ESRI\WaterUtils\ArcHydro\Bin).
- Drag the file ArcHydroTools.xml onto the file XMLViewEdit.exe.
- Navigate to the node HydroConfig/ProgParams/LocationType>Vector.
- Right-click Vector and select Edit Text.
- Set the value to 0 (mdb). 1 is for gdb. Click OK. Click Save twice to keep your changes and then close the XML Viewer.

**Editing the XML associated to the map document**

- Click ApUtilities>XML Manager and navigate to the node FrameworkConfig/HydroConfig/ProgParams/LocationType>Vector.
- Right-click Vector and select Edit Text.
- Set the value to 0 (mdb). 1 is for gdb. Click OK. Close the XML Viewer and save the mxd.
**Default temporary workspace used by the tools**

The tools will use temporary folders named based on the current time stamp formatted as `yyyyyymmddhhmmss` in the Windows temp location for the user (e.g. `C:\Users\username\AppData\Local\Temp`).

The contents of the temporary location that are not locked can be deleted from ArcMap by using the function `ApUtilities > Additional Utilities > Clean User’s Temp Folder`.

**Dataset Setup**

The existing data to be used in an Arc Hydro project can be stored in any geodatabase and loaded in the map. Rasters (Grids) used in the tools should be stored and created on the disk, not in a geodatabase. The core processes of the functions are processing Grids – if the rasters are not Grids, then each raster processing function needs to convert back and forth between rasters and Grids, which decreases performance. The data created with the Arc Hydro tools will be stored in a new geodatabase that has the same name as the stored project (unless pointed to an existing geodatabase) and in the same directory where the project has been saved. By default, the new raster data are stored in the subdirectory with the same name as the dataset in the map (under the directory where the project is stored). The location of the vector, raster, and time series data can be explicitly specified using the function `ApUtilities>Set Target Locations`. They can be reset to the default location associated to the map document using `ApUtilities>Additional Utilities>Reset Target Locations`.

**Important Considerations before starting a new Arc Hydro Project**

One of the major sources of errors when starting a new Arc Hydro project is to add first data having inappropriate spatial reference. The first layer added to the map sets the spatial reference for the map dataframe. It will be used by Arc Hydro to set the projection of the output target dataset if it does not already exist and if the there is no input data passing a spatial reference (e.g. when creating Batch Point).

- The first layer added the map needs to have a projected coordinate system - it **MUST** not use a geographic projection system.
- Arc Hydro will use the default extent associated to the projection.
- You can now save the map before adding any data since the target locations are created only when the tools are used and not when the map is saved.
Tutorial Data

There are 3 distinct sets of data used in this tutorial:

- Global: data used when testing the global functions (see Global Functions section)
- Hillsborough: data used when testing the morphology functions (see Terrain Morphology section)
- SanMarcos: main data used in this tutorial

The main data used in this tutorial is stored in the SanMarcos subdirectory. It is derived from the NHD Plus data for the 8-digit hydrological unit 12100203 (San Marcos, Texas). This data was downloaded from the NHD Plus site (http://www.horizon-systems.com/nhdplus/index.php → Data Extensions → HUC8 Dataset page).

The data downloaded had shapefiles (geographic) and grids (projected, Albers).

The tutorial data was created by importing the vector data of interest into a new personal geodatabase (SanMarcos.gdb) in a feature dataset having the same spatial reference as the projected grids. The following data was imported/created:
- Catchment: polygon feature class
- NHDFlowline: stream features
- NHDWaterbody: lake features
- ProjectArea: subset of catchments

The elevation grid elev_cm stores the elevation in centimeters and has linear units in meters. Its projection file was edited to indicate that the elevation values are in centimeters. Zunits in the projection file represents the number of zunits that are needed to equal one meter. For example, for a ground unit in meters, a z-unit in centimeter is defined as:

Units  METERS
Zunits 100 as there are 100 cm in 1m.

For a ground unit in feet, a z-unit in centimeter is defined as:

Units  FEET
Zunits 100 as there are 100 cm in 1m.

The original prj.adf field in the elev_cm directory had the Zunits set to NO. This file was edited to set the ZUnits to 100.

Original projection file
Edited projection file

You are now going to add the data into a new map and save it.

- Open a new ArcMap document if needed.
- Click on the icon to add the elevation grid elev_cm.

Note: raster should be stored as Grid in a directory on the disk, not in a geodatabase, to improve performance.

- In the dialog box, navigate to Data\SanMarcos and select the raster file elev_cm. Click on the “Add” button. This raster is projected and covers the study area of interest.
The added file is listed in the Table of contents of Arc Map.

- Add NHDFlowline and NHDWaterbody into the Table of Contents.
- Save the map as Tutorial.mxd.

You are now ready to start using the Arc Hydro tools. The tutorial will walk you through the tools in each menu.
Terrain Preprocessing

Terrain Preprocessing uses DEM (digital elevation model) to identify the surface drainage pattern. Once preprocessed, the DEM and its derivatives can be used for efficient watershed delineation and stream network generation.

The steps in the Terrain Preprocessing menu should be performed in sequential order, from top to bottom. The processes to use depend on the type and quality of the initial DEM. Processing must be completed before Watershed Processing functions can be used.

The objective of this tutorial is to walk you through each function sequentially, not to present possible workflows. Workflows using the terrain preprocessing tools are discussed in details in the document “Comprehensive terrain preprocessing using Arc Hydro tools”.

![Terrain Preprocessing Menu]

- Data Management Terrain Preprocessing
- DEM Manipulation
  - Level DEM
  - Build Walls
  - Flow Accumulation
  - Flow Direction
  - Flow Direction with Sinks
  - Adjust Flow Direction in Lakes
  - Flow with Streams
  - Stream Segmentation
  - Stream Definition
  - Stream Link and Sink Link
  - Data Management DEM Manipulation
  - Build Walls
  - Sink Prescreenering
  - Sink Evaluation
  - Depression Evaluation
  - Sink Selection
  - Fill Sinks
DEM Manipulation

The DEM Manipulation menu contains functions that allow editing the original DEM:
- Level DEM: assign constant elevations under lake polygons
- DEM Reconditioning: burn in existing streams
- Assign Stream Slope/Burn Stream Slope: burn in stream slopes
- Build Walls: burn in existing boundaries
- Deranged (non dendritic) Terrain Evaluation functions: define real sinks in the DEM (for non dendritic terrains)
  o Sink Prescreening
  o Sink Evaluation
  o Depression Evaluation
  o Sink Selection
- Fill Sinks

These functions may be skipped if your original DEM has already been edited and is ready for processing. The tutorial will step through each function in the DEM Manipulation menu.

1. Level DEM

This function modifies a DEM by setting the cells within the selected Lake Polygon features to the associated FillElev value. The function works on a selected set of polygon features or on all features if there is no selected set.

The function needs as input a raw DEM and a lake polygon feature class (e.g. lake) that both have to be present in the map document.

- Select Terrain Preprocessing | DEM Manipulation | Level DEM.
- Select the appropriate input DEM and Lake Polygon feature. The output is a leveled DEM under the lakes (default name LevelDEM).
- Specify the field storing the Fill Elevation: all cells within each polygon feature will be set to the associated Fill Elevation. Selecting "None" triggers the recomputation of the FillElev value that will be stored in the field LevelElev. If the FillElev value is Null, the cells within the corresponding Lake Polygon feature will be assigned NoData. If you are using NHDPlus data, select None and click OK.
If you select None and the Z-Unit has not been set for your DEM, you will see the following message:

If the elevation is in the same unit as the linear unit of your DEM (e.g. both are in meters), then you can proceed as this is the default assumption. However, if the elevation is in a different unit (e.g. cm), then you need to set the Z-Unit before proceeding further. Click No in that case and refer to the section How To… → Define ground unit and z-unit of the online help for instructions on setting the Z-unit and repeat the previous steps to level the DEM.

**Note**
You can check the effect of the function by subtracting the original DEM from the output Level DEM using the Spatial Analyst geoprocessing tool Minus.

![Minus Tool](image)
2. DEM Reconditioning

This function modifies a DEM by imposing linear features onto it (burning/fencing). It is an implementation of the AGREE method developed at the University of Texas at Austin in 1997. For a full reference to the procedure refer to the web link http://www.ce.utexas.edu/prof/maidment/GISHYDRO/ferdi/research/agree/agree.html.

The function needs as input a raw DEM (or LevelDEM) and a linear feature class (e.g. river to burn in) that both have to be present in the map document.

- Select Terrain Preprocessing | DEM Manipulation | DEM Reconditioning.
- Select the appropriate input dem and linear feature (streams to burn in). The output is a reconditioned Agree DEM (default name AgreeDEM).

- Enter a Stream buffer: this is the number of cells around the linear feature for which the smoothing will occur.
- Enter the Smooth drop/raise value: this is the amount (in vertical units) that the linear feature will be dropped (if the number is positive) or the fence extruded (if the number is negative). This value will be used to interpolate the DEM into the buffered area (between the boundary of the buffer and the dropped/raised vector feature).
- Enter the Sharp drop/raise value: this is the additional amount (in vertical units) that the linear feature will be dropped (if the number is positive) or the fence extruded (if the number is negative). This results in additional burning/fencing on top of the smooth buffer interpolation and needs to be performed to preserve the linear features used for burning/fencing.
3. Assign Stream Slope

This function allows assigning relative stream slopes to the input Stream feature class that will be used by the function Burn Stream Slope to burn in slopes in the DEM. The function Assign Stream Slope requires the fields From_Node and To_Node to be populated first. You can create and populate these fields by using first the function Attributes Tools>Generate From/To Node for Lines for example. Assign Stream Slope will populate the FromElev and ToElev fields for each stream feature with relative elevations.

- Select Attribute Tools > Generate From/To Node for Lines and specify NHDFlowline as input Line Layer. Click OK.

The function creates and populates the fields FROM_NODE and TO_NODE in the attributes table of NHDFlowline.

- Select Terrain Preprocessing | DEM Manipulation | Assign Stream Slope.
- Specify the input Stream layer for which you want to assign stream slopes.
- Specify the maximum start elevation that will be assigned to the from nodes of the most upstream stream features and the elevation drop between 2 nodes. Click OK.
The function creates and populates the fields FromElev and ToElev.

The function performs the following steps;

**Step 1:** Generate an initial list of head reaches.

**Step 2:** Loop through the list of head streams: For each head reach, travel downstream to the outlet based on FromNode/ToNode.

At each node, check if the elevation has been assigned:

- If elevation has not been assigned: assign StartElevation to FromNode of head reach and an elevation that is one DropElevation lower than the upstream node.

- If elevation has been assigned: check whether the assigned elevation is lower than the upstream elevation:
  - If yes: do nothing
  - If no: drop the elevation by one DropElevation unit from the upstream node and continue processing downstream

- At each node, check if there is more than one downstream reach.
  - If yes: proceed along one of the downstream reach and add the other to the head reach for later processing.
  - If no: proceed along the downstream reach

Once all downstream nodes are processed, the processing of that head reach is completed.

**Step 3:** Go to the next head reach in the list and repeat the process.
4. Burn Stream Slope

This function allows burning streams with slopes built based on FromElev and ToElev values in the input Stream feature class. This function may be used on top of DEM Reconditioning since it burns only the cells located under the Stream features (no buffering). It ensures that the water flows in the digitized stream direction once it reaches a stream which may not have been the case for flat (for example for flat DEMs).

Notes
This function is integrated in the Flow Direction with Stream function.

This function may be time intensive (about 15 mn when using the tutorial data).

- Select Terrain Preprocessing | DEM Manipulation | Burn Stream Slope

- Select the input DEM to modify and "Stream" feature class preprocessed using the Assign Stream Slope function. Enter the name of the output "Stream Sloped DEM" and "Edit Points" feature class and click OK.

The function performs the following steps:

- Retrieve the step size from the XML. It is defined as a fraction of cell size and default to 0.75.

- Retrieve the minimum elevation of the input DEM.

- Create Edit Points for each from node and to node, as well as for point located along each line using the previous step size as interval.

- For each point stores the current DEM elevation of the underlying cell as well as the new elevation computed by linear interpolation of the FromElev and ToElev along this line feature.

- Set the elevation of each cell under an Edit Point feature to the Minimum elevation of the input DEM – Maximum FromElev from Stream feature class + New Elevation stored associated to the point. Basically, the elevations along the streams will be dropped below the minimum elevation of the input DEM and will be decreasing towards the outlet.
- Raise the DEM by maximum drop value + 10 to ensure positive values in the DEM.

5. Build Walls

This function allows “building” walls in the input grid. Two types of walls may be created:
- Outer walls – based on an input polygon feature class (Outer Wall Polygon)
- Inner walls – based on an input polygon, line or point feature class (Inner Wall Feature)
Both types may be built at the same time, but at least one must be selected.

In addition, a Breach Line feature class may be provided as input, to ensure that they are “breaches” in the walls allowing the water to flow out.

If you are using the Tutorial data, add the feature class ProjectArea from the SanMarcos geodatabase into the Table of Contents. This feature class is a subset of the NHD Plus Catchment feature class and will be used to define the external walls (defining the project area) and the internal walls (defining known internal boundaries).

- Select Terrain Preprocessing | DEM Manipulation | Build Walls
- Confirm that the input for DEM is “DEM” (or “AgreeDEM” after using DEM Reconditioning, or StrSlpDEM after Burn Stream Slope). The output is the Walled DEM layer, named by default “WalledDEM”.
Select the Outer Wall Polygon (optional) to ensure that the outer boundary of the Catchment feature class matches a specific boundary. Use ProjectArea if you are using the tutorial data.

Select the Inner Wall Feature class (optional) to ensure internal watersheds/catchments boundary match specific input data. Use ProjectArea as well if you are using the tutorial data.

Select a Breach Line feature class that contains features crossing the walls so that the water can flow out. Use NHDFlowline if you are using the tutorial data.

Enter the Inner Wall Height. The Outer Wall Height is twice this height.

Enter a buffer (number of cells) for the Inner Walls. Default to 0, i.e. no buffer.

Enter a buffer for the Breach Line. Default to 0, i.e. no buffer.

Click OK. Upon successful completion of the process, the “WalledDEM” layer is added to the map.

Note
If you setup an external wall, note that the resulting WalledDEM is slightly larger than the external boundary. This is to ensure that the flow directions will be correctly computed at the boundary. The Flow Direction function will shrink the resulting Flow Direction grid so that it matches the external boundaries.
The next 4 functions in the menu (Sink Prescreening, Sink Evaluation, Depression Evaluation and Sink Selection) are used to determine potential sinks in a DEM that should be preserved. They can be skipped when dealing with a dendritic terrain where all sinks should be filled. The functions are applied to the tutorial data to illustrate how they work but they could be skipped.

6. Sink Prescreening

This function allows prescreening the potential sinks in the input non filled DEM by filling the pits with a drainage area smaller than the specified area threshold defining a potential sink. Sink Prescreening is useful to reduce the number of potential sinks processed by the function Sink Evaluation.

- Select Terrain Preprocessing | DEM Manipulation | Sink Prescreening

- Specify the input Raw DEM to prescreen (e.g. StrSlpDEM) and the output PreFilled DEM and Sink grids.

- Specify the minimum drainage area for a pit to be considered a potential sink in data units and click OK.
The function generates and adds to the map the output Sink grid showing the prescreened sinks and the PreFilled DEM grid where the pits not meeting the criterion have been filled.

7. Sink Evaluation

This function allows generating the Sink Polygon and Sink Drainage Area feature classes for the input DEM as well as characterizing the sink features.

**Note**
Running the function Sink Prescreening to prescreen the input DEM to keep only the potential sinks of interest (PreFillDEM).

- Select Terrain Preprocessing | DEM Manipulation | Sink Evaluation
Select the input DEM and specify the output Sink Polygon and Sink Drainage Area feature classes. Click OK.

If you see the message below, you need to edit the projection file of the input DEM grid to indicate that the zunits are in centime. Close ArcMap, edit the projection file prj.adf and reopen ArcMap. Then rerun the function.

The function generates and characterizes the output Sink Polygon and Sink Drainage Area feature classes and adds them into the map.

The function performs the following steps:

- Generate the Flow Direction Grid associated to the input DEM and uses this grid to define the Sink Polygon features.
- Generate the drainage areas associated to the sinks.
- Characterize the sinks.

The function populates the following attributes:

<table>
<thead>
<tr>
<th>HydroID</th>
<th>GridID</th>
<th>DrainID</th>
<th>ISink</th>
<th>FillDepth</th>
<th>FillArea</th>
<th>FillVolume</th>
<th>BottomElev</th>
<th>FillElev</th>
<th>DrainArea</th>
</tr>
</thead>
<tbody>
<tr>
<td>365</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0.28</td>
<td>2700</td>
<td>441</td>
<td>463.3</td>
<td>463.45</td>
<td>2025960</td>
</tr>
<tr>
<td>367</td>
<td>2</td>
<td>2</td>
<td>0</td>
<td>0.11</td>
<td>2700</td>
<td>153</td>
<td>420.71</td>
<td>420.82</td>
<td>2760060</td>
</tr>
<tr>
<td>369</td>
<td>3</td>
<td>3</td>
<td>0</td>
<td>0.57</td>
<td>2700</td>
<td>954</td>
<td>497.35</td>
<td>408.52</td>
<td>1134000</td>
</tr>
<tr>
<td>360</td>
<td>4</td>
<td>4</td>
<td>0</td>
<td>0.29</td>
<td>2700</td>
<td>390</td>
<td>541.98</td>
<td>541.36</td>
<td>1466100</td>
</tr>
<tr>
<td>361</td>
<td>5</td>
<td>5</td>
<td>0</td>
<td>0.97</td>
<td>3600</td>
<td>1404</td>
<td>519.96</td>
<td>519.93</td>
<td>3231900</td>
</tr>
<tr>
<td>362</td>
<td>6</td>
<td>6</td>
<td>0</td>
<td>0.07</td>
<td>3600</td>
<td>180</td>
<td>213.24</td>
<td>213.21</td>
<td>1316700</td>
</tr>
<tr>
<td>363</td>
<td>7</td>
<td>7</td>
<td>0</td>
<td>0.42</td>
<td>9000</td>
<td>1998</td>
<td>210.43</td>
<td>210.85</td>
<td>1168300</td>
</tr>
</tbody>
</table>
Sink Polygon

- HydroID: Unique identifier in the geodatabase.
- DrainID: HydroID of the associated drainage area.
- IsSink: Indicator (0/1) populated with 0 by default. Populated by function Sink Evaluation and used by function Sink Selection.
- Fill Depth: FillElev – BottomElev
- FillArea: Area of the sink feature in data units.
- FillVolume: Volume of the sink.
- BottomElev: Lowest elevation within the sink feature in data unit.
- FillElev: Lowest elevation of the boundary cells located outside of the sink (e.g. lowest elevation of the outside cell along the boundary of the sink where the spill would occur first when the sink fills)
- DrainArea: Area of the associated drainage area in data unit.

Sink Drainage Area

- HydroID: Unique identifier of the drainage area in the geodatabase.

8. Depression Evaluation

This function allows generating the Depression and Depression Drainage Area feature classes for the input DEM as well as characterizing the depression features.

- Select Terrain Preprocessing | DEM Manipulation | Depression Evaluation
- Select the input DEM and specify the output Depression and Depression Drainage Area feature classes. Click OK.

The function generates and characterizes the output Depression and Depression Drainage Area feature classes and adds them into the map.

The function performs the following steps:
- Fill the input DEM.
- Generate the Depression by subtracting the input DEM from the filled DEM
- Generate the Flow Direction Grid associated to the filled DEM and uses this grid to define the drainage areas associated to the depressions.
- Characterize the depressions.

The function populates the following attributes:

**Depression**
- HydroID: Unique identifier in the geodatabase.
- DrainID: HydroID of the associated drainage area.
- IsSink: Indicator (0/1) populated with 0 by default. Populated by function Depression Evaluation and used by function Sink Selection.
- Fill Depth: FillElev – BottomElev
- FillArea: Area of the depression feature in data units.
- FillVolume: Volume of the depression.
- BottomElev: Lowest elevation within the depression feature in data unit.
- FillElev: Lowest elevation of the boundary cells located outside of depression (e.g. lowest elevation of the outside cell along the boundary of the depression where the spill would occur first when the depression fills)
- DrainArea: Area of the associated drainage area in data unit.
Depression Drainage Area
- HydroID: Unique identifier of the drainage area in the geodatabase.

9. Sink Selection
This function allows selecting the Deranged Polygon features (e.g. sinks, depression) that should be considered as sinks. The function works on a selected set of features or on all features if there is no selected set.

- Select Terrain Preprocessing | DEM Manipulation | Sink Selection

- Select the input feature class containing the polygons that need to be characterized as sinks.

- Specify the criteria defining a sink and click OK. Only the input features having values strictly greater than the specified thresholds are considered as sinks
The function checks that the selected input contains the required fields.

**Deranged Polygon**

*Required fields (populated by function Sink Evaluation)*
- FillDepth
- FillArea
- FillVolume
- DrainArea

*Field created*
- IsSink

The function updates the attribute IsSink and sets it to 1 for the features that meet the criteria specified. If “Overwrite Selection” is unchecked, the function will not reset to 0 the features not meeting the criteria that have IsSink set to 1.
10. Fill Sinks

This function fills the sinks in a grid. If a cell is surrounded by higher elevation cells, the water is trapped in that cell and cannot flow. The Fill Sinks function modifies the elevation value to eliminate these problems. You have the option to fill all the sinks in the input DEM, all the sinks with a depth lower than the specified threshold, or all sinks except those defined as real sinks in the Deranged Polygon feature class (for non dendritic terrain). You are going to run the function twice. The first time, you fill all the sinks to create a filled grid called FillAll. The second time, you will not fill the SinkPoly features having IsSink set to 1 (i.e. those defined as sinks).

First run

- Select Terrain Preprocessing | DEM Reconditioning | Fill Sinks.

- Confirm that the input for DEM is “PreFillDEM”. Set the optional input Deranged Polygon to Null. If provided, it defines the areas that will not be filled (e.g. real sinks). The Use IsSink Field, if checked, restricts the Deranged Polygons to the ones having IsSink=1. The output is the Hydro DEM layer, named by default “Fil”. Rename this output grid FilAll.

- Select Fill All to fill all sinks and not only the sinks, whose depth is lower than the threshold provided.

- Press OK. Upon successful completion of the process, the “FilAll” grid is added to the map.
Second run

- Select Terrain Preprocessing | DEM Reconditioning | Fill Sinks.

- Confirm that the input for DEM is “PreFillDEM”. Set the optional input Deranged Polygon to SinkPoly to define the areas that will not be filled (real sinks). Check Use IsSink Field to restrict the Deranged Polygons to the ones having IsSink=1. Rename the output Hydro DEM layer FillSink.

- Check Fill All.

- Press OK. Upon successful completion of the process, the “FilSink” layer is added to the map.
Terrain Processing

Once you are satisfied with the resulting edited DEM, you can proceed to the functions that will create the data supporting the delineation process: Flow Direction Grid, Stream Grid, Catchment and AdjointCatchment.

1. Flow Direction

This function computes the flow direction for a given grid. The values in the cells of the flow direction grid indicate the direction of the steepest descent from that cell. The function Flow Direction with Sinks may be used instead to process a DEM with known sinks.

- Select Terrain Preprocessing | Flow Direction.

- Confirm that the input for Hydro DEM is “FilAll”, i.e. the entirely filled grid. The output is the Flow Direction Grid, named by default “Fdr”. This default name can be overwritten. Rename the output grid “FdrFilled”.

- If you have previously used the function Build Walls to fence in an external wall, you need to use again the Outer Wall Polygon to clip the Flow Direction grid correctly. Set this output to Null since you did not use Build Walls when generating FillAll.

- Press OK. Upon successful completion of the process, the flow direction grid “FdrFilled” is added to the map.

FdrFilled has 8 distinct values, each indicating the direction in which the water is flowing (255 would indicate sinks – they are none since the grid has been entirely filled).
2. Flow Direction with Sinks

This function computes the flow direction for a grid with sinks to ensure that all cells within a sink watershed flows into this watershed’s sink point. The values in the cells of the flow direction grid indicate the direction of the steepest descent from that cell. The function Flow Direction may be used instead to process a DEM with no sinks.

- Select Terrain Preprocessing | Flow Direction with Sinks.

- Confirm that the input for Hydro DEM is “FilSink”, i.e. the grid not entirely filled. Rename the output Flow Direction Grid “FdrSink”.

- If you have previously used the function Build Walls to fence in an external wall, you need to use again the Outer Wall Polygon to clip the Flow Direction grid correctly. Set this input to Null as you did not use Build Walls to generate FilSink.

- Select the Deranged Polygon feature class that defines the sinks. If this feature class contains the field IsSink, only the selected features having IsSink=1 will be considered as sinks by the function and processed.

- Press OK. Upon successful completion of the process, the Flow Direction grid “FdrSink”, the Sink Point feature class, the Sink Link grid and the Sink Watershed grid are added to the map.
The function creates a Sink Point for each processed sink and generates the Flow Direction grid so that each cell in a sink flows toward its sink point.

The Sink Link grid may be used as the link grid input in Catchment Grid Delineation to generate catchment grids for an entirely “deranged” terrain (i.e. with sinks), or it can be combined with a stream link to generate that input link grid (for a combined dendritic/deranged terrain).

The Sink Watershed Grid is a grid representing the area draining into each sink. Both the Sink Watershed grid and the Sink Link grid may be used to mask these areas when generating stream links with the function Stream Segmentation so that no stream links are generated within the sink watersheds or sinks.

Note
You can use the Flow Path Tracing tool ( ) to view the paths based on the new flow direction grid by clicking the tool and then clicking on the map to start the trace. All traces in a given sink watershed will end at that watershed’s sink point.

You can delete the traces by selecting the graphics and pressing the Delete key.

Flow paths within a sink watershed flowing into the sink point

3. Adjust Flow Direction in Lakes

This function modifies the input Flow Direction Grid within the selected Lake Polygon features so that each cell within a lake flows toward the closest stream in that lake.

- Select Terrain Preprocessing | Adjust Flow Direction in Lakes.
 Confirm that the input for Flow Direction Grid is “FdrSink”, Lake Polygon a lake polygon feature class (e.g. NHDWaterbody) and Stream a line feature class (e.g. NHDFlowline). The output is the Bowled Flow Direction Grid, named by default “BowIFdr”. This default name can be overwritten.

The 2 pictures below show 2 flow paths from the same point within a lake feature. The picture on the left shows the original path based on the FdrFilled grid and the picture on the right shows the path based on the BowlFdr grid (you can use the Data Management Terrain Processing function to switch the Flow Direction grid used by the Flow Path Tracing tool).

4. Flow Accumulation

This function computes the flow accumulation grid that contains the accumulated number of cells upstream of a cell, for each cell in the input grid. You are going to use the totally filled DEM to generate the flow accumulation as the area being processed in the tutorial is dendritic and does not have sinks.

 Select Terrain Preprocessing | Flow Accumulation.

 Confirm that the input of the Flow Direction Grid is “BowIFdr”. The output is the Flow Accumulation Grid with the default name of “Fac” that can be overwritten.
5. Stream Definition

This function computes a stream grid based on a flow accumulation grid and a user specified threshold. The cells in the input flow accumulation grid that have a value greater than the threshold are assigned a value of 1 in the stream grid. All other cells are assigned no data.

- Select Terrain Preprocessing | Stream Definition.

- Confirm that the input for the Flow Accumulation Grid is “Fac”. The output is the Stream Grid. “Str” is its default name that can be overwritten.

A default value is displayed for the river threshold. This value represents 1% of the maximum flow accumulation: it is the recommended threshold for stream determination. Note that these streams are used to prepare preprocessed data that will help speed up point delineation. These streams do not need to be meaningful or representative of existing streams. Any other value of threshold can be selected. Smaller threshold will result in denser stream network and usually in a greater number of delineated catchments, which may hinder delineation performance. If the ground units have been set (otherwise Area will be grayed out), the threshold may also be set using the area in square kilometer. Check the online help (How to… Define ground unit and z-unit for more information on how to set the ground units).
• Press OK. Upon successful completion of the process, the stream grid “Str” is added to the map.

6. Stream Segmentation

This function creates a grid of stream segments that have a unique identification. A segment may either be a head segment, or it may be defined as a segment between two segment junctions. All the cells in a particular segment have the same grid code that is specific to that segment. The input Sink Watershed Grid and Sink Link Grid are optional and may be used to mask the input stream grid so that no stream links are created in those areas.

- Select Terrain Preprocessing | Stream Segmentation.
- Confirm that “bowlfdr” and “Str” are the inputs for the Flow Direction Grid and the Stream Grid respectively. You can specify a Sink Watershed Grid or Sink Link Grid if needed (i.e. if you do not want to create drainage line features and catchments within the sinks/sink watersheds). Set these optional inputs to Null. The output is the Stream Link Grid, with the default name “StrLnk” that can be overwritten.

- Press OK. Upon successful completion of the process, the link grid “StrLnk” is added to the map.

7. Flow Direction with Streams

This function generates the Drainage Line feature class from an existing stream layer using first the input Flow Direction grid. It subsequently uses again the stream layer to add the flow splits. This function may be used instead of the Stream Definition function to match as closely as possible the input stream (i.e. length, flow splits). The function edits the input flow direction grid to generate an output Stream Sloped Flow Direction grid that ensures that the water remains within a given stream and does not jump between streams near the confluences.
The function also generates the output Stream Link grid required to generate the catchments.

The output Edit Points and HydroRiverPoints are created and used during the grid editing process.

The input DEM used to generate the Flow Direction grid should have gone through the DEM Reconditioning step using the same Stream layer as the one used to burn in the streams. However it is not required to burn in stream slopes into that DEM as the function will be performing this step.

This function is calling the geoprocessing tool with the same name in the Arc Hydro tools toolbox. You may need to close ArcCatalog before running this function otherwise you may get a lock error.

The input Stream feature class must contain a populated HydroID field. You are first going to assign HydroIDs to that feature class.

- Select Attributes Tools | Assign HydroID.

- Select the Workspace of the NHDFlowline feature class and select NHDFlowline by clicking on it. Select not to overwrite and to apply to all features and click OK.

The function creates the field HydroID and populates it with unique identifies in that geodatabase.

- Select Terrain Preprocessing | Flow Direction with Streams.

- Select the input “Flow Direction Grid” (used the flow direction associated to the filled grid) and the input stream layer. Specify the output names and click OK.
The processing status is displayed in the Command Line window.

The function performs the following operations:

- Create Edit Points by scanning each input stream feature starting from the From Point. The points are snapped to the center of the cells and all points creating a 90 degree angle between their previous and next points are removed to avoid creating thick lines.

- New Drainage Line features are created by connecting the clean edit points.

- Flow Direction is adjusted for every cell under the drainage line to make sure it flows to the next point along the line in the downstream direction. The cell at the confluence directs the flow to the first downstream drainage line if there is more than one.

- New HydroRiver points are created to represent stream links. At the confluence, if there is a flow split, the first drainage line gets the ownership of the confluence. Otherwise, the line originating from the confluence "owns" the confluence.

- HydroRiver Points (LinkID = HydroID of the drainage line) are converted to StreamLink Grid.

Drainage Line feature class

- HydroID: unique identifier of the Drainage Line feature in the geodatabase
- NextDownID: HydroID of next downstream feature. If there is more than one downstream feature, additional NextDownIDs are stored in the flow split table named after the Drainage Line feature class (i.e. DrainageLine1_FS for DrainageLine1). FEATUREID in the flow split table stores the HydroID of the Drainage Line feature.
- FeatureID: HydroID of associated Stream feature (e.g. NHDFlowline).
8. **Combine Stream Link and Sink Link**

This function creates a link grid combining the stream link grid representing dendritic areas and the sink link grid representing deranged areas (i.e. areas with sinks). The Link grid is used to generate catchments – one catchment will be created for each link and will represent the area draining into that link.

- Select Terrain Preprocessing | Combine Stream Link and Sink Link.

- Confirm that the input to the Stream Link Grid and Sink Link Grid are “StrLnk” and “SinkLnk” respectively. The output is the combined Link Grid with a default name of “Lnk” that can be overwritten by the user.
The function generates the output Link Grid by first retrieving the maximum value from the input Stream Link and adding this value to the Sink Link grid and then merging the resulting grid with the Stream Link Grid. This ensures that each link has a unique value in the resulting Link Grid and that the stream link ids (and the associated relationships between catchments and drainage lines) are maintained in the resulting Link Grid.

**Note**

If a sinklink is connected to a streamlink, the sinklink is assigned the values of the connectivited streamlink to support the connectivity. This works however only when there is no more than one streamlink connected to any given sinklink. The case where multiple streamlinks connect to a given sinklink is not supported at this time.
9. Catchment Grid Delineation

This function creates a grid in which each cell carries a value (grid code) indicating to which catchment the cell belongs. The value corresponds to the value carried by the stream segment or sink link that drains that area, defined in the input stream segment link grid (Stream Segmentation) or sink link grid (Sink Segmentation). You are going to use the Stream Link generated using the Stream Segmentation function.

- Select Terrain Preprocessing | Catchment Grid Delineation.
- Confirm that the input to the Flow Direction Grid and Link Grid are “BowlFdr” and “StrLnk”. The output is the Catchment Grid layer. “Cat” is its default name that can be overwritten by the user.

- Press OK. Upon successful completion of the process, the catchment grid “Cat” is added to the map.

10. Catchment Polygon Processing

This function converts a catchment grid it into a catchment polygon feature class.

- Select Terrain Preprocessing | Catchment Polygon Processing.
- Confirm that the input to the Catchment Grid is “Cat”. The output is the Catchment polygon feature class, having the default name “Catchment” that can be overwritten.
- Press OK. Upon successful completion of the process, the polygon feature class “Catchment” is added to the map.

- Open the attributes table of Catchment. The field GridID stores the grid value for the associated Catchment Grid. HydroID is a unique identifier that allows uniquely identifying features in the target geodatabase (i.e. the target vector workspace).

11. Drainage Line Processing
This function converts the input Stream Link grid usually created with the Stream Segmentation function into a Drainage Line feature class. Each line in the feature class carries the identifier of the catchment in which it resides. Note that the function Flow Direction with Streams also generates the Drainage Line feature class based on the input Stream feature class.

- Select Terrain Preprocessing | Drainage Line Processing.
- Confirm that the inputs to Stream Link Grid is “StrLnk” and to Flow Direction Grid “BowlFdr”. The output Drainage Line has the default name “DrainageLine” that can be overwritten.

- Press OK. Upon successful completion of the process, the linear feature class “Drainage Line” is added to the map.
- Open the attributes table of DrainageLine. GridID contains the GridID of the corresponding Catchment. NextDownID contains the HydroID of the next downstream DrainageLine feature or “-1” if there are no downstream features.

**Note**
The flow split table DrainageLine_FS is created empty as there are no divergences.
12. Adjoint Catchment Processing

This function generates the aggregated upstream catchments from the "Catchment" feature class. For each catchment that is not a head catchment, a polygon representing the whole upstream area draining to its inlet point is constructed and stored in a feature class that has an "Adjoint Catchment" tag. This feature class is used to speed up the point delineation process.

The input Drainage Line and Catchment feature classes must contain the field GridID – a catchment and its associated drainage line shares the same GridID that is the ID of the corresponding link used to generate those features (from the stream link or link grid). If using a link grid that combines stream links and sink links (for a combined terrain with both dendritic and deranged terrains with sinks), the combined link grid must use the same id as the stream link for those links. Those stream link ids are preserved when using the function Combine Stream Link and Sink Link to create a combined sink link.

- Select Terrain Preprocessing | Adjoint Catchment Processing.
- Confirm that the inputs to Drainage Line and Catchment are respectively “DrainageLine” and “Catchment”. The output is Adjoint Catchment, with a default name “AdjointCatchment” that can be overwritten.

- Press OK. Upon successful completion of the process, the polygon feature class “AdjointCatchment” is added into the map.
- Open the attributes table of AdjointCatchment: HydroID is the unique identifier of the adjoint catchment and GridID contains the GridID of the catchment immediately downstream from the adjoint catchment. DrainID stores the HydroID of the downstream catchment.
Open the attributes table of Catchment. Adjoint Catchment Processing has added the field NextDownID that contains the HydroID of the next downstream catchment (“-1” if there is no downstream catchment).

**Note**
The function also creates and populates the flow split table for the Catchment (e.g. Catchment_FS). This table is created empty when there are no flow divergences.
Open the attributes table of DrainageLine. Adjoint Catchment Processing has added the field DrainID that contains the HydroID of the catchment corresponding to the drainage line.

13. Drainage Point Processing

This function allows generating the drainage points associated to the catchments.

- Select Terrain Preprocessing | Drainage Point Processing.
- Confirm that the input to Drainage Line is “DrainageLine”, and the input to Catchment is “Catchment”. The output is Drainage Point, having the default name “DrainagePoint” that can be overwritten.
- Press OK. Upon successful completion of the process, the point feature class "DrainagePoint" is added to the map.

- Open the attributes table of DrainagePoint. HydroID is the unique identifier in the geodatabase. GridID is the value of the catchment grid draining to the drainage point. DrainID is the HydroID of the associated catchment.
14. Longest Flow Path for Catchments

This function allows generating the longest flow paths associated to the catchments. This is required to speed up the generation of Longest Flow Paths. If you do not plan to generate these types of features, you may skip this step as well as the next one.

Note
This function may be time-consuming.

- Select Terrain Preprocessing | Longest Flow Path for Catchments

- Confirm that the input to Flow Direction Grid is “BowlFdr”, and the input to Catchment is “Catchment”. The output is Longest Flow Path Catchment, having the default name “LongestFlowPathCat” that can be overwritten.

- Press OK. Upon successful completion of the process, the longest flow path for catchments feature class “LongestFlowPathCat” is added to the map.
Open the attributes table of LongestFlowPathCat. HydroID is the unique identifier in the geodatabase. DrainID is the HydroID of the associated catchment. LengthDown is the length from the start of the flow path to the basin outlet in map units.

### 15. Longest Flow Path for Adjoint Catchments

This function allows generating the longest flow paths associated to the adjoint catchments.

- Select Terrain Preprocessing | Longest Flow Path for Adjoint Catchments

- Confirm that the input to Flow Direction Grid is “BowlFdr”, the input to Adjoint Catchment “AdjointCatchment” and the input to Longest Flow Path Catchment “LongestFlowPathCat”. The output is Longest Flow Path Adjoint Catchment, having the default name “LongestFlowPathAdjCat” that can be overwritten.

Press OK. Upon successful completion of the process, the longest flow path for adjoint catchments feature class “LongestFlowPathCat” is added to the map.

- Open the attributes table of LongestFlowPathAdjCat. DrainID is the HydroID of the associated adjoint catchment.
Other Functions

1. Slope

This function allows generating a slope grid in percent or degree for a given DEM.

- Select Terrain Preprocessing | Slope.
- Confirm that the input to Raw DEM is an unprocessed DEM (e.g. elev_cm) and specify the type of slope grid to create (slope in percent or in degree). The output is the slope grid for that DEM, having the default name “WshSlope” that can be overwritten.

Note
The tool computes the zfactor based on the Z unit set for the input DEM. If the Z unit is not set, the tool assumes that the Z unit is the same as the linear unit and uses a zfactor of 1.
Watershed Processing

The steps in Terrain Preprocessing need to be performed before the watershed delineation functions may be used. The preprocessing functions partition terrain into manageable units to allow fast delineation operations.

Delineation Functions

1. Batch Watershed Delineation

This function performs batch watershed delineation for points in an input Batch Point feature class. This point feature class must contain four required fields:
   - Name
   - Descript
   - BatchDone
   - SnapOn

The Arc Hydro tool Batch Point Generation may be used to interactively create the Batch Point feature class.
To create the Batch Point input file.

- Click on the icon on the Arc Hydro Tools toolbar.
- Keep the default name for the output BatchPoint feature class and click OK.

The BatchPoint feature class BatchPoint1 will be added to the Table of Contents.

- Click with the mouse on the map to create a point at a location where you want to delineate a watershed (e.g. on a Drainage Line feature). The following form is displayed:

  Fill in the fields Name and Description. Both are string fields.

  The BatchDone option indicates whether the Batch Watershed Delineation function will perform a delineation for that point (0: delineate, 1: do not delineate).

  The SnapOn option indicates whether the Batch Watershed Delineation function will try to snap the point to the closest stream.

  The Type field (SrcType) indicates whether the point is an outlet or an inlet, and defaults to outlet. This field is used by the function Watershed Processing>Delineate from Multiple Inlets and Outlets.
Select the options shown above.

- Create another point, and fill in the Name and Description with Name 2 and Description 2.

- Open the attribute table of BatchPoint. BatchDone = 0 means that Batch Point Delineation will process the 2 points.

Note
The SrcType field uses the domain PointSourceType (0-Outlet, 1-Inlet). You may need to close and reopen ArcMap to see the description instead of the code in the SrcType field.

The Generate Batch Point tool prompts for the name of Batch Point feature class each time the icon is clicked (except when the tool is still activated). To be able to place multiple batch points while navigating the map using zoom in/zoom out/pan without having to reset the feature class, you need to use the mouse navigation shortcut. Otherwise, if you click the navigation tools specifically, you will need to reset the Batch Point feature class each time.

To perform a batch watershed delineation

- Select Watershed Processing | Batch Watershed Delineation.

- Confirm that “BowlFdr” is the input to Flow Direction Grid, “Str” to Stream Grid, “Catchment” to Catchment, “AdjointCatchment” to AdjointCatchment, and “BatchPoint1” to “Batch Point”. You can leave Snap Stream Grid to Null. This is an optional input used for snapping. If it is not set, the Stream Grid will be used for snapping.
instead. For output, the Watershed Point is “WatershedPoint”, and Watershed is “Watershed”. “WatershedPoint” and “Watershed” are default names that can be overwritten.

![Batch Watershed Delineation dialog box]

- Press OK. The following message box appears on the screen, indicating that 2 points have been successfully processed.

![Batch Watershed Delineation message box]

**Note**
If the message indicates that some of the delineations were successful with warning, you need to review the input Batch Point feature class and look for the fields having BatchDone=2. This value indicates points that have been snapped into a catchment that is different from the catchment initially associated to the input point.

The delineated watersheds are shown below.
- Open the attributes table of Batch Point. BatchDone now contains the value 1 that indicates that the watershed associated to each point has been delineated. If an error occurs during delineation, the field BatchDone is updated with the value -1.

- Open the attributes table of WatershedPoint and Watershed. WatershedPoint and Watershed are related to BatchPoint through the Name field. The DrainID in WatershedPoint stores the HydroID of the corresponding Watershed.
Note: New watershed and watershed point features will be appended to the feature classes.

2. **Batch Subwatershed Delineation**

This function allows delineating subwatersheds for all the points in a selected Point Feature Class. Input to the batch subwatershed delineation function is a point feature class with point locations of interest. The Batch Point Generation function can be used to interactively create such a file.

To create the input Point Feature Class

- Click on the icon in the Arc Hydro toolbar to activate the Batch Point Generation tool and display the input form. Enter “SubBatchPoint” for the Batch Point feature class. Click OK.
- Click with the mouse on the map at the location of the new point to generate.
- Fill in the fields Name and Description in the form.

The BatchDone and SnapOn options are used in batch subwatershed delineation in the same way as in batch watershed delineation.

- Create another point on the map downstream from the first point. Fill in the name and description with Name 4 and Description 4.

- Select Watershed Processing | Batch Subwatershed Delineation.
- Confirm that the input to the Flow Direction Grid is “BowlFdr”, to the Stream Grid (“Str”) and to the Batch Point feature class “SubBatchPoint”. The output Subwatershed is named by default “Subwatershed” and the output Subwatershed Point “SubwatershedPoint”. These names may be overwritten.
• Press OK. The delineated subwatersheds are shown below.

Notes

The function will delineate only the SubBatchPoint features having BatchDone=0.

The old Subwatershed and Subwatershed Point records will be deleted each time a new delineation is performed, since for subwatersheds the number of points to delineate has an impact on the result.

3. Batch Global Watershed Delineation

See Global Functions section.

4. Batch Watershed Delineation for Polygons

This function performs batch watershed delineation for selected polygons in an input Batch Polygon feature class. The polygons will usually belong to an existing layer and represents an area of interest (e.g. Political boundaries, lakes, study area, etc.). In this tutorial, you will delineate watersheds for 2 of the biggest lake features from the NHDWaterbody feature class. You will first need to import the features in a feature class in the same feature dataset as the Catchment feature class.
- Open the Catalog window if not already open by clicking on the Windows menu in ArcMap and selecting Catalog.

- In the Catalog window, browse to the Home database (tutorial) and right-click your target feature dataset (e.g. Layers). Select Import > Feature Class (single).

- Select NHDWaterbody as Input Features and your target feature dataset for the output location.

- Enter BatchPolygon as Output Feature Class and enter “Shape_Area” > 600000 as Expression to import only the 2 biggest features. Click OK.
The 2 Waterbody features will be imported into a new feature class called Batch Polygon.

- Add the new BatchPolygon feature class into the Table of Contents if not already there.

- Select Watershed Processing | Batch Watershed Delineation for Polygons.

- Confirm that “BowlFdr” is the input to Flow Direction Grid and “BatchPolygon” to Batch Polygon. For output, type “WatershedPoly” for “Watershed”. “Watershed” is the default name that can be overwritten. Click OK and proceed if warned that all features will be processed.

The function delineates the watersheds associated to each input polygon feature and stores the resulting features in the output WatershedPoly feature class.
The 2 delineated watersheds are displayed below.

- Open the attributes table of BatchPolygon. The fields DrainID and BatchDone have been appended. DrainID stores the HydroID of the associated watershed. BatchDone is set to 1 indicating that the watershed associated to an input polygon has been successfully delineated. If an error occurs during delineation, the field BatchDone will be updated with the value -1. Only the watersheds having no BatchDone field, or BatchDone set to 0 or null are processed.

- Open the attributes table of WatershedPoly. The HydroID in WatershedPoly is stored in the DrainID field of the source BatchPoly feature.
Notes

New watershed features will be appended to the output watershed feature class.

HydroIDs and DrainIDs may not be populated if the BatchPolygon feature class is not located in the target geodatabase.

The input Batch Polygon feature class must have the same spatial reference as the preprocessed data. One way of ensuring this is to import the input Batch Polygon in the same feature dataset as the supporting data.

5. **Delineate from Multiple Inlets and Outlets**

This function delineates one watershed at a time based on selected inlet and outlet point in an input Point Source feature class. In this tutorial, you will create a new point source feature class using the BatchPoint tool.

This point feature class uses the field SrcType to differentiate between inlets and outlets (SrcType= 0 for outlet, 1 for inlet).

You will follow the steps below to create along a drainage line feature in the upstream direction: 1 outlet, 1 inlet, 1 outlet and 1 inlet as shown below.

- Click on the icon in the Arc Hydro Tools toolbar.
- Confirm that the name of the batch point feature class is “PointSource” and click OK.
The PointSource feature class will be added to the Table of Contents.

- Click with the mouse on the map to create a new point in the downstream section of a DrainageLine. Make sure the point is located on the stream grid.

The following form is displayed:

![Batch Point Generation](image)

Note that only the field Type is used by the function Delineate from Multiple Inlets and Outlets. Other fields may be left blank. The field Type defaults to Outlet.

- Check that Type is set to Outlet and click OK to create a new point of type outlet.
- Click upstream on the same stream and create a new point of type inlet.
- Click upstream on the same stream and create a new point of type outlet.
- Click upstream on the same stream and create a new point of type inlet.
- Open the Attributes table of PointSource.
To perform a delineation from multiple inlets and outlets

- Select Watershed Processing | Delineate From Multiple Inlets and Outlets.

- Confirm that “BowlFdr” is the input to Flow Direction Grid, “str” to Stream grid, and the previously created “PointSource” to Point Source. For output, type “WatershedPntSource” for “Watershed and “WatershedPointPntSource” for WatershedPoint. Click OK.

The function delineates the watershed based on the combination of inlets/outlets and stores the resulting feature in the output WatershedPntSource feature class. The following message is displayed indicating that the watershed has been successfully delineated.
The DrainID field in the WatershedPoint feature class stores the HydroID of the associated watershed.
Note: New watershed features will be appended to the output watershed feature class.

Watershed Characterization Functions

1. Drainage Area Centroid

This function generates the centroid of drainage areas as centers of gravity. However, if the center of gravity is not located within the polygon, the function will use as centroid the projection of the center of gravity on the polygon’s boundary (i.e. the nearest point on the boundary). The function operates on a selected set of drainage areas in the input Drainage Area feature class. If no drainage area has been selected, the function operates on all the drainage areas.

- Select Watershed Processing | Drainage Area Centroid.
- Confirm that the input to Drainage Area is “Watershed”. The output of Centroid is “Centroid”. “Centroid” is a default name that can be overwritten.
Press OK to calculate the centroids for the catchments.

The DrainID in the Attributes table of Centroid is the HydroID of the corresponding Drainage Area feature.

### 2. Longest Flow Path

This function identifies and computes the length of the longest flow path in a selected set of drainage areas (e.g. any polygon feature class). If no drainage area has been selected, the function processes all the drainage areas.

- Select Watershed Processing | Longest Flow Path.
- Confirm that the input to the Flow Direction Grid is “BowlFdr”, and the input to Drainage Area is “Watershed”. The output of Longest Flow Path is “LongestFlowPath”. “LongestFlowPath” is a default name that can be overwritten.

- Press OK to calculate the longest flow path. Upon completion of the operation the LongestFlowPath linear feature class is added to the map.

The DrainID in the Attributes table of Longest Flow Path is the HydroID of the associated Drainage Area feature.
3. Longest Flow Path for Watersheds

This function generates the longest flow paths for input watersheds more efficiently than the previous function because it relies on preprocessed data to speed up the process.

- Select Watershed Processing | Longest Flow Path for Watersheds.
- Confirm the inputs to Catchment, Adjoint Catchment, Watershed, Watershed Point, Longest Flow Path Adjoint Catchment, Drainage Line and Flow Direction Grid. Rename the output Longest Flow Path “LongestFlowPathWsh” not to overwrite the feature previously created. Click OK.

The DrainID in the Attributes table of LongestFlowPathWsh is the HydroID of the associated watershed.
4. Longest Flow Path for Subwatersheds

This function generates the longest flow paths for input subwatersheds more efficiently than the Longest Flow Path function because it relies on preprocessed data to speed up the process.

- Select Watershed Processing | Longest Flow Path for Subwatersheds.

- Confirm the inputs to Catchment, Subwatershed, Subwatershed Point, Longest Flow Path Catchment and Flow Direction Grid. Rename the output Longest Flow Path “LongestFlowPathSubwsh”. Click OK.

- The DrainID in the Attributes table of LongestFlowPathSubwsh is the HydroID of the associated subwatershed.
5. **Main Flow Path**

This function allows generating the Main Flow Path features for the selected watersheds. The function Attribute Tools > Populate DrainArea in Drainage Line must be used before running this function to populate the area draining into each drainage line.

- Select Attribute Tools | Populate DrainArea for Drainage Line. Select DrainageLine, Catchment and AdjointCatchment and click OK.

This function creates the field DrainArea in the attributes table of DrainageLine and populates it with the total area draining into the drainage line, computed by summing up the areas of its associated catchment and adjoint catchment. The area is in data units.
- Select the watershed features to process. The function will process each feature if there is no selected set.

- Select Watershed Processing | Main Flow Path.

- Specify the input layers RawDEM (elev_cm), Flow Direction (BowlFdr), Flow Accumulation grids as well as the input Watershed, Watershed Point, Drainage Line feature classes. Specify the name of the output Main Flow Path line feature class.

- Specify a small stream threshold – this is the point from where the line will be extended to the boundary to minimize the curvature-weighted flow path. This threshold should be smaller than the threshold used to define the Drainage Line feature class (e.g. 450 cells). Click OK.
For each selected watershed, the function checks whether the watershed point is located on a drainage line.

- If it is, the function looks for the head drainage line as the most upstream line located along the path that maximize the drainage area, i.e. if there is more than one upstream line, the one selected is the one having the biggest DrainArea. The function sets the from node from the head drainage line as “big node”

- Otherwise, the function sets the watershed point as “big node”.

- The function delineates the watershed at the big node and calculates the longest flow path to the boundary of the original watershed.

- The function locates the “small node” on the previous longest flow path that matches the small threshold and delineates a watershed from that point. It then calculates the cost path to the original watershed boundary that minimizes the curvature-weighted flow length to define the from point of the Main Flow Path.

The DrainID of the MainFlowPath feature class stores the HydroID of the associated watershed.
The results will vary depending on the threshold used to generate the Drainage Line feature class and the small threshold specified. It will also vary depending on the watershed boundary as the from point is placed on the boundary of the original watershed.
6. Construct 3D Line

This function allows building the 3D (z-aware) lines corresponding to a selected set of 2D lines by extracting elevations from an input DEM. Elevations are stored in the X/Y unit of the input DEM.

- Select Watershed Processing | Construct 3D Line.
- Select LongestFlowPath as input Line 2D feature class and your unprocessed dem (e.g. elev_cm) as Raw DEM. The output Line 3D is called by default Line3D. Rename the output LFP3D and click OK.

The 3D Line (Polyline Z shape) corresponding to the selected input 2D Line (Polyline shape) is generated. It contains the same attributes as the input line as well as the Line2DID attribute, which stores the HydroID of the associated 2D line.
Notes
The 3D Line has more vertices than the 2D Line so that z values are known along the line and not only at the vertices of the 2D Line.

If you have the 3D Analyst extension you can use the Profile tool to view the profile of a selected feature.

7. Smooth 3D Line

This function smoothes a 3D line oriented in the downstream direction. Smoothing is performed linearly along each line feature.

- Select Watershed Processing | Smooth 3D Line.
- Select the input 3D Line feature class containing features to smooth and enter a name for the output line (e.g. SmoothLFP3D). Click OK.
The Smooth Line 3D (Polyline Z shape) corresponding to the selected input 3D Line is generated. It contains the same attributes as the input line as well as the Line3DID attribute, which stores the HydroID of the associated 3D line.

Note
If you have the Spatial Analyst extension, you can use the Profile tool to display the profile of a selected 3D feature.
8. Flow Path Parameters from 2D Line

This function computes the longest flow path length, the slope, the 10-85 slope and the 10-85 points associated to the longest flow paths features. The slopes values are stored in the Longest Flow Path feature class. This function works on the selected longest flow paths features or on all the features if none are selected. Elevations are extracted from the input raw dem.

- Select the longest flow path features to process. The function will process all features if there is no selected set.
- Select Watershed Processing | Longest Flow Path Parameters | Flow Path Parameters from 2D Line.
- Confirm that the input to the elevation grid Hydro DEM grid is the Raw DEM (e.g. elev_cm), and the input to the Longest Flow Path is “LongestFlowPath”. Enter a name for the output Slope 1085 Point feature class. Click OK.

The function computes the following parameters:
- LengthMi: Length of longest flow path feature in miles.
- SlpFM: Slope in feet per mile.
- Slp1085FM: 10-85 slope in feet per mile.
- Slp: Dimensionless slope.
- Slp1085: Dimensionless 10-85 slope.
Arc Hydro Tools v2.0 – Tutorial

- ElevUP: Upstream elevation in XY units of the DEM.
- ElevDS: Downstream elevation in XY units of the DEM.
- Elev10: Elevation at 10% along the flow path from the outlet in XY units of the DEM.
- Elev85: Elevation at 85% along the flow path from the outlet in XY units of the DEM.

The function also creates the 10-85 points associated to each flow path and stores their elevation in XY units of the DEM.

9. Flow Path Parameters from 3D Line

This function computes the same parameters as the previous function by reading elevations from the 3D lines instead of from the input DEM.


- Select the input smooth 3D line feature class (SmoothLine3D) and enter a name for the output Slope 1085 Point feature class. Click OK.
The function computes the slopes and generates the 10-85 points associated to the longest flow path features processed.

10. Basin Length Points
This function allows generating inlet and outlet points associated to an input line (e.g. longest flow path for a watershed) that will be used by the function Basin Length to generate the basin length line between these 2 points for a given drainage area.

- Select Longest flow path features in the map. The features need to have a DrainID defining the HydroID of the associated drainage area.
- Select Watershed Processing | Basin Length Points.
- Select the input Basin Length Grid (e.g. your Raw DEM, elev_cm), Drainage Area feature class (e.g. Watershed) and Longest Flow Path feature class. Enter a name for the output Basin Length Point feature class. Click OK.
The function generates the Basin Length Point feature class that stores the from point and to point associated to each input Longest Flow Path line. The DrainID field is populated with the DrainID of the input Longest Flow Path feature. HydroID is the unique identifier of the new point features in the geodatabase. SrcType defined whether the point is a from point (1-Inlet) or a to point (0-Outlet). The input Basin Length grid is used to ensure spatial consistency – it should be the same as the one used when computing the basin length.

11. Basin Length

The Basin Length function allows generating a cost path line from the inlet point to the outlet point of a basin traveling through a cost surface that has minimum values toward the center and maximum values at the boundary. Unlike longest flow path, this function does not use the flow direction for the cost path. It uses the geometry to travel through the approximated centroid of the basin. This function works on a selected set of a drainage area having associated basin length points (inlet and outlet points).

- Select the watershed features for which you have just generated basin length points.
- Select Watershed Processing | Basin Length.
Select the input Raw DEM grid (same as the one used in the previous function) and Drainage Area and Basin Length Point feature classes. Enter a name for the output Basin Length line feature class. Click OK.

The function generates the Basin Length line feature for each selected drainage area. The DrainID field is populated with the HydroID of the associated Drainage Area feature. HydroID is the unique identifier of the feature in the geodatabase. LengthMi stores the length of the Basin Length line in miles.
Basin Length (purple) vs. Longest Flow Path (brown)
Network Tools

If the dataset already has the geometric network with Hydro Edges and Hydro Junctions layers defined, you can directly use all the Attribute Tools. However, if you are coming from a raster environment as we are in this example, you will need to use the Network Tools to generate the geometric network before you can use some of the Attribute Tools. The functions required at least an Arc Editor license.

1. Hydro Network Generation

This function allows converting drainage features into network features, and creating the associated geometric network. It also creates a relationship class (HydroJunctionHasCatchment) between the new HydroJunction feature class (HydroJunction) and the Catchment feature class that will be used subsequently.

- Select Network Tools | Hydro Network Generation.
- Confirm that the input to Drainage Line is “DrainageLine”, to Catchment “Catchment”, and to Drainage Point “DrainagePoint”. The output Hydro Edge is named by default “HydroEdge”, and the output Hydro Junction “HydroJunction”. These names can be overwritten. The output network name defaults to ArcHydro.
The network generated, named “ArcHydro”, is added to the Utility Network Analyst as shown below (the Utility Network Analyst toolbar needs to be loaded manually, if not present in the ArcMap document).

Sometimes even after the successful completion of the operation, the HydroEdge and HydroJunction layer may not show in the map, and the network may not be added to the Utility Network Analyst. In such cases, you need to manually add these layers.

- To manually add these layers, click on the icon to add data. Navigate to the location of data, and select the HydroEdge and HydroJunction layers to add them to the map (or select the network – this will load both layers).

**Note**
You may need to close and reopen the map document to see the domains’ description in the attributes tables instead of the domains’ codes.
The function creates and populates the field JunctionID in the attributes table of Catchment with the HydroID of the associated HydroJunction feature, and creates a relationship between the Catchment and the HydroJunction feature classes.
2. Node/Link Schema Generation

This function allows generating a node-link schema. The nodes are defined by the centers of the polygons representing basins and by points that represent locations of interest in the model. The points include basin outlets, river junctions, water intakes and other facilities.

The function requires that the relationship between the Watershed Polygons and their outlet be established through the JunctionID field, and the relationship between the Junctions and their next downstream junction be established through the NextDownID field.

- Select Network Tools | Node/Link Schema Generation.

- Confirm that the input to Watershed Polygons is “Catchment” and to Junctions “HydroJunction”. The defaults names for the outputs, Schema Link and Schema Node, are respectively “SchemaLink” and “SchemaNode”. These names can be overwritten.
Press OK. The links and nodes are generated as shown below.
3. Store Flow Direction

This function reads the flow direction for a set of edges from the network and writes the value of the flow direction to the FlowDir field in the Edge Feature Class.

- Select Network Tools | Store Flow Direction.
- Select “HydroEdge” under Layers by clicking on the name or on Select All. Click OK.
Press OK. The FlowDir field in the Hydro Edge feature class is populated with the specified flow direction for each feature.

4. Set Flow Direction

This function sets the flow direction for selected edges in a network edge feature class. If no features are selected, the tool sets the flow direction for all the edges in the feature class.

- Select Network Tools | Set Flow Direction.
- Select “HydroEdge” under Layers and choose “With Digitized Direction” for the Flow Direction.

Press OK. The flow direction is set for the Hydro Edge in the digitized direction.
Attribute Tools

If your dataset already has the geometric network with HydroEdge and HydroJunction layers defined, you do not need to use the “Hydro Network Generation” tool. You can directly use the Attribute Tools.

1. Assign HydroID

In general, Assign HydroID should be used only for those feature classes that have not been generated with the Arc Hydro tools (e.g. importing a batch point file or a catchment layer digitized from source maps). This tool only creates HydroIDs for features in selected feature classes. It does NOT maintain attribute relations (For example, DrainID field of a catchment centroid contains the HydroID of the catchment in which the centroid resides. If the HydroID of the catchment is changed using the HydroID tool, the corresponding DrainID will not be changed).

- Open the attributes tables for “Centroid” previously created.
- Select Attribute Tools | Assign HydroID.
- The Assign HydroID form shown below is displayed on the screen.
Select the map/dataframe containing the layer “Centroid”. You should only have “Layers” available, unless you have several data framed in the ArcMap TOC.

Select the workspace so that you can see the layer “Centroid”. If all the vector feature classes have been created in the same default workspace, you should have only one target workspace available in addition to the source data workspace.

Select “Centroid” in the list of layers available.

Finally, select to overwrite the existing features, and to apply to all features. Click OK.

The function overwrites the HydroID fields in the “Centroid” layer.
2. Generate From/To Node for Lines

This function creates and populates the fields FROM_NODE and TO_NODE in the selected input linear feature class.

- Select Attribute Tools | Generate From/To Node for Lines.

- Confirm that the input of Line is “HydroEdge” (this tool will operate on any line feature class).

- Press OK. The fields FROM_NODE and TO_NODE are created and populated in the attribute table of “HydroEdge”.

![Original HydroIDs](image1.png)

![Updated HydroIDs](image2.png)
3. **Find Next Downstream Line**

This function finds the next downstream feature(s) in a linear feature class based on the digitized direction. It creates and populates the field NextDownID with the HydroID of the first next down feature. The HydroID of any additional downstream feature is stored in the flow split table.

- Open the Attributes table of “HydroEdge” and scroll all the way to the right.
- Select Attribute Tools | Find Next Downstream Line.
- Confirm that the input to Line is “HydroEdge”.
- Press OK. The field NextDownID is created and populated in the Attributes table of HydroEdge.

The Find Next Downstream Line function can also handle flow splits, i.e. a line having more than one downstream feature. In this case, the HydroID of the first downstream feature is used to populate the field NextDownID in the feature class. The HydroIDs of the other downstream features are stored in the flow split table.

If you have a DrainageLine created from NHD Plus data using the function Drainage Line from Stream (e.g. DrainageLine1), it probably contains flow split. You can add its associated table (DrainageLine1_FS) to view how the flow splits are handled.
Otherwise, you can edit your Drainage Line feature class and add flow splits by following the steps described below:

- Add the Drainage Line feature class into ArcMap if needed. This feature class was created from grids and does not contain any flow splits.

- Click Editor>Start Editing and select Drainage Line as target.

- Click Editor>Snapping>Snapping Toolbar. Make sure “End Snapping” is selected.

- Digitize a few flow splits by snapping to the end of existing drainage lines. Stop editing and save your edits.

- Select **Attribute Tools | Generate From/To Node for Lines**, select DrainageLine as Line and click OK to populate the From and To Nodes fields for the new drainage lines.

- Select **Attribute Tools | Find Next Downstream Line** and select DrainageLine as line. Click OK.

The function populates the NextDownID fields in the Drainage Line feature class with the HydroID of the first downstream feature found. It creates the flow split table DrainageLine_FS in the same workspace as DrainageLine.

- Click Add Data and browse to the geodatabase storing the DrainageLine feature class. Add the DrainageLine_FS into the table of contents of ArcMap.

- Right-click the flow split table DrainageLine_FS and select Open. FeatureID stores the HydroID of the drainage line currently processed while NextDownID stores the HydroID of additional downstream lines.

- Remove the newly created flow splits from the Drainage Line feature class, save your edits and rerun the Find Next Downstream Line function.
4. **Populate DrainArea for Drainage Line**

This function allows calculating the area draining into a drainage line as the sum of the areas of the catchment and adjoint catchment associated to the drainage line. The area is stored in the field DrainArea in the Drainage Line feature class. It is used by the function Main Flow Path to determine the head Drainage Line feature.

- Select Attribute Tools | Populate DrainArea for Drainage Line.
- Specify the layers to use as Drainage Line, Catchment and Adjoint Catchment and click OK.

The function populates the field DrainArea in the Drainage Line feature class.

5. **Calculate Length Downstream for Edges**

This function calculates the length from a network edge to the sink that the edge flows and populates the field LengthDown in that feature class with the calculated value.

- Select Attribute Tools | Calculate Length Downstream for Edges.

The function requires the flow direction to be set in the input edge. The flow direction was automatically set by the function Hydro Network Generation, and set again with Set Flow Direction.

- Select “HydroEdge” under Layers and select the field containing the length for the edges (“Shape_Length”) from the drop down list.
6. Calculate Length Downstream for Junctions

This function calculates the length from a network junction to the sink that the junction flows, and populates the field LengthDown in that feature class with the calculated value.

- Select Attribute Tools | Calculate Length Downstream for Junctions.

This function requires that the flow direction be set on the network.

- Select “HydroJunction” under Layers. Select the length field for each edge feature class in the network (Note: there is only one, “HydroEdge”). Select “Shape_Length” from the drop down list.
Press OK. The field LengthDown is created and populated in the Attributes table of HydroJunction.

7. Find Next Downstream Junction

This function finds the next downstream junction in a junction feature class based on the flow direction set in the network, and assigns the HydroID of this downstream feature to the NextDownID field in the feature class.

- Select Attribute Tools | Find Next Downstream Junction.
The function requires the flow direction to be set in the geometric network

- Select “HydroJunction” under Layers.
- Select “HydroID” as the common HydroID field in the network.
- Check “No” to skip checks for spatially coincident junctions.
- Click OK.

The calculated next downstream ID of junctions is stored in the NextDownID field in the attribute table of “HydroJunction”.
8. **Store Area Outlets – Junction Intersect Method**

This function locates the outlet junctions for a selected set of areas and assigns the HydroID of the junction to the JunctionID field in the corresponding area feature class. If no features are selected, the tool runs on all records. The JunctionID field is created if it does not already exist in the area feature class.

- Add a new field called JunctionID1 as Long Integer in the Catchment feature class. Populate it with the valued from the JunctionID field then reset JunctionID to null for all features.

- Select Attribute Tools | Store Area Outlets| Junction Intersect Method.

- Confirm that the input of the Area layer is “Catchment” and the input to the Hydro Junction layer is “HydroJunction”. Enter “45” as search tolerance and select Meters as unit.

- Check “Near Area Boundary” as well as the 2 advanced options and click OK.
The function identifies the potential outlets using the HydroJunction feature class and populates the field JunctionID with the HydroID of the HydroJunctions.
9. Store Area Outlets – Drainage Point Proximity Method

This function locates the outlet junctions for a selected set of areas and assigns the HydroID of the junction to the JunctionID field in the corresponding area feature class. If no features are selected, the tool runs on all records. The JunctionID field is created if it does not already exist in the area feature class. The function looks for the HydroJunction near the Drainage Point associated to the Area feature and selects as outlet those that are located in the same Area feature as the Drainage Point.

- Reset the field JunctionID to Null in the Catchment feature class.
- Select Attribute Tools | Store Area Outlets | Drainage Point Proximity Method.
- Confirm that the input of the Area layer is “Catchment” and the inputs to the Hydro Junction and DrainagePoint “HydroJunction” and “DrainagePoint”. Enter “50” as search tolerance and select Meters as unit. Click OK.

The function identifies the potential outlets using the HydroJunction feature class and populates the field JunctionID with the HydroID of the HydroJunctions.

The function cannot identify any outlet and populates the field Junction with -1. The following message is displayed. The HydroJunction features are not located in the same Area feature as the Drainage Point associated to the Area.
10. Store Area Outlets – Next Downstream Area Method

This function populates the Null JunctionIDs with the JunctionID of the next Downstream Area feature.

- Repopulate the field JunctionID by running the function Store Area Outlet – Junction Intersect Method.
- Select a couple of Catchments and reset their JunctionID to Null.
- Select Attribute Tools | Store Area Outlets| Next Downstream Area Method.

The tool populates the field JunctionID with the JunctionID associated to the next downstream Area feature.
10. Reset the JunctionID for the selected Catchments to Null and repopulate their JunctionID using Store Area Outlet – Junction Intersect Method.

11. Consolidate Attributes

This function allows consolidating the source attribute in the source layer based on a relationship between the source layer and the target layer. Only layers having relationships may be selected as target or source layer. The source has to be different from the layer and related to it.

For example, the function may be used to calculate the total area of all the catchments related to each Hydro Junction.

- Select one Hydro Junction on the map and open the Attribute table of HydroJunction. Select Show Selected.

- Select Options>Related Tables>HydroJunctionHasCatchment
HydroJunctionHasCatchment is a relationship class between the HydroJunction and the Catchment feature classes. The JunctionID in Catchment relates to the HydroID in HydroJunction.

The Attribute table of Catchment displays the Catchments related to the selected HydroJunction.
• Clear the selection.

• Select Attribute Tools | Consolidate Attributes.

The following form is displayed:

- Select “HydroJunction” as Target Feature Layer.
Enter “ConsolidatedArea” as Target Field. The function will create this field in the target layer, “HydroJunction”.

- Select “Catchment” as Source Feature Layer.
- Select “Shape_Area” as Source Field, which will be consolidated.
- Select “Sum” as the consolidation operation, and press OK.

The function uses the relationship class to retrieve the Catchments associated to a particular Hydro Junction, sums their areas, and stores the result in the field “ConsolidatedArea” in the Attributes table of “HydroJunction”.

12. Accumulate Attributes

This function allows accumulating attributes of target features located upstream of source features. Target features may either belong to the source feature class, or to a layer related to the source feature class. Upstream target features are related by performing a trace on the target feature class or on a related feature class. Two types of trace may be used: based on a geometric network; based on the NextDownID attribute.

For example, this function may be used to calculate the total area draining to each Hydro Junction.

- Select Attribute Tools | Accumulate Attributes.
- The following form is displayed on the screen.
Select “HydroJunction” as Network Layer to use for the trace.

Select “Catchment” as Source Feature Layer and “Shape_Area” as Source Field.

Select “Sum” as Accumulation operation.

Select “HydroJunction” as Target Feature Layer and type AccumulatedArea for Target Field.

Click OK.

For each Hydro Junction being processed, the function performs a trace to locate all the upstream Hydro Junctions. It locates all the catchments (source features) related to these junctions, sums their
areas, and stores the resulting value in the “AccumulatedArea” field in the Attribute table. This field contains the total upstream area for each Hydro Junction.

13. Compute Local Parameters

This function allows computing area characteristics (e.g. average elevation, area, etc.) for selected polygon feature(s) in the input Drainage Area polygon feature class and storing them in the attributes table of the polygon layer (Note: if no features are selected then parameters will be computed for all the features in the input polygon feature class). Examples of parameters that may be computed are:

- Area in square miles
- Average elevation in feet
- Maximum elevation in feet
- Minimum elevation in feet
- Relief (Difference between the maximum and the minimum elevations) in feet
- Average slope in percent
- Percentage of a given type of land cover (e.g. forest)
- Mean precipitation in the unit of the precipitation grid (e.g. inches).

Notes
The Raster Target dataset, if not set, needs to be set for the HydroConfig node by using the function ApUtilities>Set Target Locations before using the function.

The function requires that both the ground units and the z unit be set for the DEM (refer to How to… Define ground unit and z-unit in the online help).

You are going to use this function to characterize the watersheds you previously delineated.

- Select Attribute Tools | Data Management Attribute Tools.
- Reset the layer tagged as “Drainage Area” to Null. Click OK.
- Select Attribute Tools | Compute Local Parameters.
- Uncheck “Select all parameters” and then check AREA2MI, CENTROIDY and ELEVFT to select the parameters that will be extracted. Click OK.

- Select “Watershed” as Drainage Area and click OK.

The function then prompts for the layer(s) needed to compute the selected parameters. Raw DEM is required to compute the average elevation. A centroid feature is generated when the function calculates the Y-coordinate of the centroid.
- Select your raw dem (e.g. elev_cm) for the Raw DEM and “Centroid1” for the output Centroid feature class (since “Centroid” already exists). Click OK.
The function computes the specified parameters (area in square miles, average elevation, Y-coordinate of the centroid) for the input watershed features and stores the results in the attributes table. The function also generates the “Centroid1” feature class and adds it into the Table of Contents.

### Notes
- Units may need to be set for Raw DEM (Ground units and z-units) and the Drainage Area Layer (z-units). Refer to the online help for additional information on how to set these units.
- Detailed instructions on available parameters and configuration of new parameters can be found in the document Local Parameters Configuration.pdf.

### 14. Compute Global Parameters

The preprocessing steps required by this function are described in the document Global Point Delineation with EDNA Data and in the online help. Once these steps have been performed, the function is used in the same way as the function Compute Local Parameters. Refer to the section Global Functions in this document for more information.
15. Compute Point Parameters

This function allows computing point characteristics (e.g. latitude, longitude, etc.) for selected point feature(s) in the input Point Layer feature class and storing them in the attributes table of the point layer (Note: if no features are selected then parameters will be computed for all the features in the input point feature class).

- Select Attribute Tools | Compute Point Parameters.

The function prompts for the parameters to compute.

- Select LATITUDE and LONGITUDE and click OK.

The function prompts for the input Point Layer feature class if not already set.

- Select WatershedPoint as Point Layer and click OK.

The function creates the fields LATITUDE and LONGITUDE if they do not already exist in the WatershedPoint feature class, computes the latitude and longitude for each selected point (or all points if there is no selected set) and stores the result in the attributes table.
16. Generate Report

This function allows generating a predefined report for a feature of interest. 2 types of report have been predefined as examples:

- Watershed Analysis
- Watershed with HU8

You will use the Watershed Analysis report in this example. This report works off a selected Watershed Point feature and retrieves the following information for the point and its associated watershed:

Watershed Point (computed using Compute Point Parameters)
- LATITUDE
- LONGITUDE

Watershed (computed using Compute Local Parameters)
- AREA2MI
- ELEVFT
- ELEVMAXFT
- ELEVMINFT
- OUTLETELEV
- RELIEFFT

You need to compute these characteristics first before using the Generate Report function. You should already have computed LATITUDE, LONGITUDE, AREA2MI and ELEVFT. Use the function Compute Local Parameters to compute ELEVMAXFT, ELEVMINFT, OUTLETELEV and RELIEFFT as well.
Once the characteristics have been computed, follow the steps below:

- Make sure the Watershed Point and Watershed feature classes are in the Table of Contents and select the Watershed Point feature of interest.

- Select Attribute Tools | Generate Report.

- Select the Watershed Analysis Report in the dropdown list and click OK.

- Specify the Watershed Point and Watershed feature classes and click OK.

The function generates a Microsoft Word report with the data extracted from the Watershed Point and Watershed features. The report contains a map showing the watershed and an overview map showing its location in the state of Texas (as an example).
Watershed Analysis Report

Wednesday, July 13, 2011

Characteristics

<table>
<thead>
<tr>
<th>Name</th>
<th>Name 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latitude</td>
<td>29.9601</td>
</tr>
<tr>
<td>Longitude</td>
<td>-97.8142</td>
</tr>
<tr>
<td>Area</td>
<td>14.62 square miles</td>
</tr>
<tr>
<td>Mean Elevation</td>
<td>701.56 ft</td>
</tr>
<tr>
<td>Maximum Elevation</td>
<td>891.15 ft</td>
</tr>
<tr>
<td>Minimum Elevation</td>
<td>562.30 ft</td>
</tr>
<tr>
<td>Outlet Elevation</td>
<td>562.30 ft</td>
</tr>
<tr>
<td>Relief</td>
<td>318.85 ft</td>
</tr>
</tbody>
</table>

Location

Watershed Map

Overview Map
17. Export Data

This function allows exporting preconfigured data of interest. 2 types of Export have been preconfigured as examples. You are going to use the Watershed Analysis Export below.

- Make sure the Watershed Point and Watershed feature classes are in the Table of Contents and select the Watershed Point feature of interest.
- Select Attribute Tools | Export Data.

Select the Watershed Analysis Export type in the dropdown list and click OK.

- Specify the Export Directory and the type of export (mdb or shapefile), as well as the spatial reference for the exported data and click OK.
The function exports the preconfigured data (in this case the selected point and its associated watershed) into the specified output format with the following naming convention: the database or shapefiles are named after the Name of the point feature, followed by the date and time of the export.
Time Series Functions

1. Display Time Series

This function allows displaying the values of a parameter associated with a feature in a target feature class over time.

For example, this function may be used to display the variation of one parameter (e.g. rainfall) over the Nexrad cells linked to the measurements. Time series data associated to the study area used in the tutorial is available in the Timeseries.mdb geodatabase in the Data\SanMarcos directory. However, if you want to use your own data, you can create time series data by following the instructions at the end of this section.

- Browse to the location of tutorial data and look for the timeseries.mdb geodatabase. Add the super_radar_cal polygon feature class and the TIMESERIES and VariableDefinition tables into the Table of Contents of ArcMap.

The polygon feature class super_radar_cal defines Nexrad cells that overlay the study area used in this tutorial (San Marcos).
The time series variables are defined in the VariableDefinition table. One variable has been defined for the tutorial, Nexrad Rainfall, with a HydroID of 3 that uniquely defines the variable in the geodatabase.
The TIMESERIES table stores time series of the Nexrad Rainfall. The FEATUREID field stores the HydroID of the NEXRAD cell associated to each record.

- Select super_radar_cal as the target layer to display (TS DISPLAY) and TimeSeries as the Time Series Table.

- The following window appears on the screen. It indicates that 20 time steps have been found for the selected parameter, Nexrad rainfall. The value displayed on the screen corresponds to the selected time step. When Show Text is checked (default), the parameter and time step are displayed on the map.
Note also that the legend associated with the target layer is automatically modified to use graduated colors. You can select the colors and the number of breaks by right-clicking the Start button: the window expands then as follows:

- Modify the legend as needed, and click OK to update the Table of Contents.
- Click Cancel to collapse the form.

Note that you can also modify the format of the number in the XML by editing the parameter NumberFormat in the XML under the node `FrameworkConfig/HydroConfig/ProgParams/ApFunctions/ApFunction(TimeSeriesDisplay)`. You still need to click OK to update the legend.

- To display the variations of the precipitation over the 20 time steps, click on Start. The Display Interval, in seconds, allows modifying the time each time step is being displayed.
The Save options allows saving one image for each time step displayed in the Images directory located in the same directory as the map document. The images are named by appending the step number starting from 0 to the name of the layer being processed (e.g. super_radar_cal).

**Note**
The templates for the tables TimeSeries and VariableDefinition are available in the Arc Hydro template schema database (ArcHydroSchema.mdb). If you cannot find the tables, you can create them directly in ArcCatalog, with the following structures:

**TimeSeries**
- FeatureID – Long: Unique ID (HydroID) of the feature to which the measurement is associated
- VarID – Long: Unique identifier of temporal variable.
- TSTime – Date: Date and time of the measurement
- TSValue – Double: Measurement value.

**VariableDefinition (note: only the two fields listed are used by the function)**
- VarName – Text: Name of the temporal variable.
2. Transfer ID

This function allows establishing a relationship between a source feature class having an existing Time Series table and a target feature class that needs to be linked to time series data. For example, you may be interested in creating time series linked to each Catchment based on the time series associated to the Nexrad cells.

This function requires first the creation of an intersect layer that is built by intersecting the source and the target feature class.

- Make ArcToolbox visible in ArcGIS.
- Browse to Analysis Tools>Overlay>Intersect and double-click Intersect.

![Intersect dialog box]

- Select the layers “Catchment” and “super_radar_cal” as input features.
- Browse to your target location and rename the output CatRadarIntersect and click OK.

The Intersect layer is generated by intersecting the layers “Catchment” and “super_radar_cal”.

- Add this layer into the map if it is not already there.
Select Attribute Tools | Time Series Processing | Transfer ID.

Select “super_radar_cal” as From Layer, “Catchment” as To Layer and “CatchRadarIntersect” as Intersect Layer. Click OK.

Select HydroID as key fields for ID transfer for both “super_radar_cal” and “Catchment”.

The function stores in the Intersect Layer the unique identifiers from the source and target feature classes, as well as the ratios of each intersect feature’s area to the area of the corresponding source and target features.
3. Transfer Value

This function allows generating a Time Series table for a polygon feature class based on an existing polygon feature and its associated Time Series table.

- Select Attribute Tools | Time Series Processing | Transfer Value.

- Select “Catchment” as To Layer, “CatRadarIntersect” as Intersect Layer, “TimeSeries” as source Time Series table and “TSTARGET” as target Time Series table. Click OK.

- Select “Nexrad rainfall” as the Time Series type to transfer. Click OK.

The function generates the target Time Series table that can now be used with the function Display Time Series.
Click Display Time Series and select “Catchment” as Target Layer and “TSTARGET” as Time Series Table. Click OK.

The map displays the Nexrad rainfall for each catchment over time.

5. Scale Design SCurve

This function allows scaling a unit hydrograph SCurve using design values stored in the selected Design Value Field in the attributes table of the Drainage Area feature class. If the user specifies a Design Region Field, then this field will be used as the FeatureID in the Time Series table. If this field is null, then the function will assume that the input time series is associated to the FeatureID 0.

To test the remaining time series function, you need first to setup a new VariableDefinition and TimeSeries tables with the data described below. Use 2 of your watershed or other polygons features as features related to the time series. You will need to use the FeatureIDs corresponding to the HydroIDs of your features.

- Create a VariableDefinition table in your target database with the following records.
Create a TIMESERIES table with the following records.
Select the features in the Drainage Layer for which unit SCurve time series need to be scaled. This feature class must contain a field storing the design value by which the unit hydrograph SCurve will be multiplied by to generate the design SCurve for that feature.

Select Attribute Tools | Time Series Processing | Scale Design SCurve.

Select the input Drainage Layer feature class, Times Series, Target Time Series and VariableDefinition tables and click OK.

Select HydroID as the field storing the Design Value for each feature (The value does not make sense). Select the field storing the Design Region identifier if the unit SCurve is defined for a region in the input Time Series. Since we have defined a unit hydrograph for each input watershed feature, we are going to select HydroID as Design Region Field to retrieve those time series. If this field is not set, the function assumes that the input time series is associated to the FeatureID 0 in the input Time Series table.

Select the input (Unit SCurve) and output (Design SCurve) time series types.

Select whether to overwrite existing records and click OK.

For each selected feature, the function will multiply the unit SCurve time series defined for that feature by the design value to create a new scaled time series.
6. Accumulate SCurve

This function allows adding up time series values to create a cumulative time series such as a SCurve.

- Select the features for which you want to compute a cumulative time series. The feature class must contain the field Hydro ID. The function will process all features if there is no selected set.

- Select Attribute Tools | Time Series Processing | Accumulate SCurve.
Select the input Drainage Layer feature class, Time Series and Variable Definition tables, and Target Time Series table and click OK.

Select the source time series type, target type (cumulative) and the start and end date for the accumulation. Click OK.

The function adds up the source time series values for each feature to create the cumulative time series of the specified type.
7. Export SCurve to RAI

This function allows exporting SCurve time series into RAI files.

- Select the features for which you want to export the time series. The feature class must contain the fields Hydro ID and Name. The function will process all features if there is no selected set.

- Select Attribute Tools | Time Series Processing | Export SCurve to RAI.

- Select the input Drainage Layer feature class, Time Series and VariableDefinition tables and click OK.

- Select as Source TSType the type of time series to export. Specify the output directory for the export and the number of decimals needed in the resulting files. Select whether to sort the results based on time and click OK.
The function generates a RAI file for each input feature that has an associated time series of the specified type. The name of each file is constructed by appending the .RAI extension to the name of the input feature read from the Name field in the input feature class.
Buttons and Tools

1. Flow Path Tracing

This tool allows creating a flow path as graphics showing the path of a drop of water on the terrain based on the Flow Direction grid.

- Click on the icon on the Arc Hydro toolbar.
- Confirm, if prompted, that the input Flow Direction Grid is “BowlFdr”. If not prompted, it means that the Flow Direction Grid is already set. You can reset it if needed by using the Data Management functions.

- Click your mouse at any point on a map to determine the flow path from that point. The flow path defines the path of flow from the selected point to the outlet following the steepest descent.

2. Interactive Flow Path Tracing

This tool allows defining the flow path as graphics first and then as a line feature from the point the user clicks on the map. The flow path ends at the outlet of the Drainage Area feature in which the start of the path is located.
- Click on the icon on the Arc Hydro toolbar.

- Confirm that the input Drainage Area feature class is “Catchment”, the input Flow Direction Grid is “BowlFdr” and the output Longest Flow Path is “LongestFlowPathInt”. Click OK.

- Click your mouse at any point to determine the flow path as graphics. The flow path defines the path of flow from the selected point to the outlet of current Drainage Area feature following the steepest descent.

- Click Yes to save the Graphics into the output Longest Flow Path feature class. The DrainID field stores the HydroID of the associated DrainageArea feature.
3. Point Delineation

This tool allows creating a watershed point at the location clicked by the user on the map and delineating the associated watershed. The function does not prompt for the inputs if they are already set.

- Click on the icon in the Arc Hydro toolbar.
- Click on the map at the location where you want to perform the delineation.
- Confirm that the input Flow Direction Grid is “BowlFdr”, the input Stream Grid and Snap Stream Grid “Str”, the input Catchment “Catchment”, and the input Adjoint Catchment “AdjointCatchment”. The output Watershed Point is “WatershedPoint”, and the output Watershed is “Watershed”. “WatershedPoint” and “Watershed” are default names that can be overwritten by the user. Rename the outputs WatershedInt and WatershedPointInt and click OK. Note that you will not be prompted for the layers if they are already set.
Choose Yes-Snap and press OK to snap the point to a snap stream grid cell (this form will not be displayed if the point clicked is already on the snap stream grid).

The tool displays the delineated watershed as graphics and prompts the user whether to save it.
Click OK and populate the name and description for the new delineated watershed as shown below in the form.

The field DrainID in the Watershed feature class stores the HydroID of its associated Watershed.
4. **Delineate using EPA Web Service**

This tool allows creating a watershed point at the location clicked by the user on the map and delineating the associated watershed using 2 EPA web services. The first service allows identifying the closest point located on a medium resolution NHDFlowline feature and returning its COMID and measure. The second service returns the watershed associated to the downstream end of that NHDFlowline. The function does not prompt for the outputs (Watershed/WatershedPoint) if they are already set.

- Click on the icon in the Arc Hydro toolbar.
- Confirm that the outputs are WatershedPoint and Watershed if prompted and click OK.
- Click on the map at the location where you delineate a watershed (Note: if the watershed is too big the services will time out).
- Click Yes to save the delineated watershed shown as graphics.

The tool returns the delineated watershed. The Name field stores the COMID of the closest medium resolution NHDFlowline and the Descript field in the WatershedPoint feature stores the concatenation of the COMID, “:”, and measure of the closest point on the NHDFlowline.
5. **Batch Point Generation**

This tool allows creating the Batch Point feature class that is used as input by the batch delineation functions in the Watershed Processing menu. You will not be prompted for the name of the output Batch Point feature class if it is already set. You can reset it by using the Data Management functions.

- Select Watershed Processing | Data Management Watershed Delineation and reset Batch Point to Null.

**Note**

If you previously used BatchPoint, which is the default name for the Batch Point feature class, the function will automatically use BatchPoint and not prompt you for a name. In this case, you need to change the default name in the XML to be able to reset Batch Point:

- Select ApUtilities>XML Manager…
- Browse to the node HydroConfig>TemplateView>ApLayers>ApLayer(BatchPoint).
- Right-click this node and select EditAttributes.
- Change the name from BatchPoint to BatchPointDefault for example and click OK.
- Close the XML Manager.
After resetting Batch Point, follow the steps below:

- Click on the icon 🗼 in the Arc Hydro Tools toolbar.

- Click with the mouse to create a point on the map. Confirm, if prompted, that the name of the batch point feature class is “BatchPointTool” and click OK.

The following form is displayed. Fill in the fields Name and Description. Both are text fields. The BatchDone and SnapOn options can be used to turn on (select 1) or off (select 0) the batch processing and stream snapping for that point. Select the options shown in the form. The point type may be Inlet (1) or Outlet (0). The inlet type is used only by the function Delineated from Multiple Inlets and Outlets in the Watershed Processing menu.

The Batch Point feature class is created if needed, and this layer stores the new point.
6. **Assign Related Identifier**

This tool allows updating an attribute for a target feature with the value of a related attribute in a source feature.

Consider for example the layers “Catchment” and “DrainagePoint”: the field “DrainID” in DrainagePoint stores the HydroID of the Catchment where the point is located.

- Select one Drainage Point feature, take note of its DrainID and update its value.

The DrainID in the DrainagePoint feature class for the point located in that watershed does not match the associated Catchment feature anymore. This can be fixed by using the Assign Related Identifier function:

- Click on the icon on the Arc Hydro toolbar.
- Select Catchment/HydroID as the source layer/field.
- Select DrainagePoint/DrainID as the target source/field.

- On the map, left-click to select the source Catchment feature.
Right-click the Drainage Point you want to edit and select Assign Related Identifier.
The DrainID of the drainage point is updated with the value of the HydroID of the selected source catchment feature.

7. **Global Point Delineation**
See Global Functions section.

8. **Trace By NextDownID Attribute**

This tool allows performing a trace on a feature class based on the NextDownID attribute. Only layers having the attribute "NextDownID" may be traced. The trace may be performed upstream, downstream or in both directions. The function allows displaying the features related to the result of the trace. It may be used for example to display the catchments located upstream and/or downstream of a specific junction.

- Click on on the Arc Hydro Tools toolbar.

The following form is displayed on the screen:
Select “HydroJunction” as the layer on which to perform the trace.

Select “Both” as Trace Type.

Select “Catchment” as the Related Layer.

Select “Related Only” under Show Selection. Click OK.

Click on the map on a Hydro Junction from which to perform the trace. Make sure that “HydroJunction” and “Catchment” are visible.

The function shows as a selected set the catchments related to the Hydro Junctions located upstream and downstream from the selected Hydro Junction.

9. Main Flow Path Tracing

The Main Flow Path Tracing tool allows performing an upstream trace on a line feature class using the FromNode, ToNode and DrainArea fields and returning as selected set the line features on the main path that maximizes the drainage areas (i.e. the flows).

Click on on the Arc Hydro Tools toolbar.

Select the input Line layer if this layer has not already been set and click OK. This layer must have the fields FromNode/ToNode/DrainArea populated. Note that the layer may be reset using the function Attribute Tools > Data Management Attribute Tools.
Click on a line feature on the map.

The tool selects the starting line as well as all the line features upstream of the clicked feature that are located along the path that maximized DrainArea. The line clicked is also displayed as a red graphics.

**Note**
The fields From_Node/To_Node may be populated by using the function Attribute Tools > Generate From/To Node for Lines. The field DrainArea may be populated by the function Attribute Tools > Populate DrainArea for Drainage Line for a Line feature class of type Drainage Line.
Terrain Morphology

The Terrain Morphology menu contains 5 functions:
- Data Management Terrain Morphology
- Drainage Area Characterization
- Drainage Boundary Definition
- Drainage Boundary Characterization
- Drainage Connectivity Characterization

The functions allow characterizing drainage areas volumes and drainage areas boundaries profile by using elevation extracted from a Grid (DEM) or a TIN, as well as creating network connectivity for non dendritic drainage areas (i.e. areas with pits).

For this menu, you are going to use a different dataset covering non dendritic area (03100205 Hillsborough, Florida). The elevation grid called elev_cm was downloaded from the NHD Plus site and processed to create the Catchment feature class and grids that will be used in this section.

- Copy the geodatabase Data\Hillsborough\morphology.mdb in the location where you will save your new map document.

- Open a new map document and add the Catchment and the DrainagePoint feature classes from the copied morphology.mdb geodatabase.

- Add as well as the filled DEM (fil) grid, the flow direction grid (Fdr) and the shaded relief grid (hillshade) from Data\Hillsborough.

- Save the map as Morphology.mxd.
Select ApUtilities > Set Target Locations and select the HydroConfig node as target location. This is the node associated to the Arc Hydro Tools. Click OK.
For Vector Data, browse to the copied morphology.mdb geodatabase. Make sure Map Level is checked to apply the change to the current dataframe (Layers by default) and click OK.

The default vector location for the Arc Hydro tools has been reset to the copied morphology.mdb for consistency in HydroIDs.
1. **Drainage Area Characterization**

The Drainage Area Characterization tool computes the cumulative areas and volumes below a given elevation (top of slice). The tool works on a selected set or on all features if there is no selected set. The function characterizes the area and volume for “slices” of the selected drainage areas. Note that selected areas that have already been processed will be reprocessed if they are selected or if there is no selected set.

- Select the Catchment feature class as Drainage Area layer storing the areas to characterize (all areas will be processed if there is no selection).
- Select Terrain Morphology | Drainage Area Characterization.
- Select the DEM (fil) containing the elevation values. This is a grid with linear units in Meters and Zunits (elevations) in centimeters.
- Leave Exclusion Area Null. This input is optional and allows specifying areas that will not be characterized (i.e. areas and volumes contributing from these areas will be subtracted).

- Enter a positive extrusion value in linear units of 10 (e.g. meters for the fil DEM). This value is optional – default to 0 (no extrusion). When a positive value is specified, the
function creates one additional record for a slice ranging from the top elevation of the drainage area to the top elevation + extrusion value (may be required for modeling).

- Enter 3 for Slice Count that defines the number of slices to create for each drainage area. Instead of specifying a number of slices, there is also the option to specify the incremental elevation in linear units to use to define the slices. Note that in addition to these slices, one initial slice will be created to characterize the bottom of the drainage area and, optionally, one additional slice may also be created if a positive extrusion value is specified.

- Keep the default name (DrainEAV) for the output Elevation Area Volume (EAV) Table.

- Leave the Overwrite check box unchecked since you are creating a brand new output table. This check box allows specifying whether to overwrite the existing characterizations associated to the drainage areas that are being processed if the EAV table already exists. If the box is checked, records corresponding to areas already processed will be overwritten in the table, whereas records for newly processed areas will be appended. If the box is unchecked, the areas already characterized will be skipped and only the records for newly processed areas will be appended.

- Click OK.

The function performs the following actions:

1. Check that the following fields exist in the attribute table of Drainage Areas and create these fields if not found:
   - MinElev: Minimum elevation of the drainage area in linear unit.
   - MaxElev: Maximum elevation of the drainage area in linear unit.
   - IsPitted: Indicate whether the drainage area has an internal pit. Must be populated before using the Drainage Boundary Characterization function and the Drainage Connectivity Characterization function (0/1). Created with null value if not existing.
   - IsDone: Indicate whether the drainage area was successfully processed (1) or not (-1) by the Drainage Area Characterization function

2. Check whether the output EAV Table exists and create the table if not found. The table is visible in the Source Tab in the Table of Contents of ArcMap. It contains the following attributes:
   - BottomElev: Bottom elevation of the slice in linear unit.
   - TopElev: Top elevation of the slice in linear unit.
   - SlicElev: Mid elevation of the slice in linear unit. Equal to (0.5*(TopElev+BottomElev))
   - CumArea: Area of the drainage area having an elevation that is less than or equal to the top elevation of the slice in linear unit squared.
   - CumVolume: Volume of water needed to fill the associated drainage area up to the top elevation of the slice in linear unit cubed.

3. If “Overwrite existing characterizations” is checked, check whether the output DrainEAV table already contains records associated to the drainage areas being processed and delete these records (i.e. old records will be overwritten). The FeatureID in the EAV table stores the HydroID of the drainage areas. For example the table below shows that the drainage area with
HydroID 3324 was previously processed since the DrainEAV table has records with FeatureID=3324. If this drainage area is selected for processing and “Overwrite existing characterizations” is checked, the associated record in the EAV table will be deleted so that the table gets updated with the most recent records.

4. Process each selected drainage area:
   - Update the following fields in the attributes table of the Drainage Area feature class:
     - MinElev: Minimum elevation for the drainage area (in linear unit)
     - MaxElev: Maximum elevation for the drainage area (in linear unit)
     - IsDone: Indicate whether the drainage area was successfully processed (1) by the Drainage Area Characterization function or not (-1). Note that this field is not used to filter drainage areas that need to be processed (i.e. the function will reprocess a drainage area even when IsDone is set to 1 or –1).
   - Add records in the EAV table to characterize each slice of the drainage area:
     - The first slice that is created for each drainage area (highlighted in blue in the table below) characterizes the bottom of the drainage area. The slice has TopElev=BottomElev=SleElev = minimum elevation of the drainage area ("27.07" in the example provided). CumArea indicates the area in the drainage area located at the bottom (900 square meters of the area have an elevation of 27.07 meters in the example provided). CumVolume is equal to 0 (there is no volume at the bottom). This slice is created in addition to the number of slices specified by the user or computed based on the incremental slice elevation value entered by the user.
Initial EAV slice

- After creating the initial slice, the function then slices the drainage area using either the number of slices or the incremental slice elevation specified by the user in the form. Note that no slice will be created for flat drainage areas since these areas are totally characterized by the initial slice (the entire drainage area is located at the bottom and the volume is always 0). The function populates the elevation, area and volume characteristics for each slice. In the example used here, the user has requested 3 slices that correspond to the records 2, 3 and 4 in the DrainEAV table, with elevations ranging from the minimum (27.07 m) to the maximum (76.17 m) elevation of the drainage area.

Incremental EAV slices

- CumArea: Area with an elevation less than or equal to the top elevation of the current slice. Note: for the top slice where TopElev=MaxElev (=76.17 in this example), CumArea (18934200) is the same as the total area of the drainage area.
- CumVolume: Total volume of water required to fill the drainage area up to the specified elevation.

- If a strictly positive extrusion value has been entered, one additional slice will be created (highlighted in blue in the table below) in addition to the number of slices specified by the user (or computed based on the specified incremental elevation). CumArea for this...
slice is the same as the total drainage area since the entire area is located under the extruded elevation. The extruded elevation is calculated by adding the extrusion value to the maximum elevation of the drainage area. CumVolume is calculated by adding to the cumulative volume of the top slice previously computed the incremental volume obtained by multiplying the total drainage area by the extrusion value. In the example below, an extrusion value of 10m (linear units) is used, or 86.17 - 76.17).

Extruded slice in EAV Table

- After processing all selected features, the function will report the number of features that were successfully processed and the number that failed.

2. Drainage Boundary Definition

The Drainage Boundary Definition function generates 3D boundary lines for selected drainage areas and stores these lines in the output “Drainage Boundary” 3D polyline feature class. The function stores in the output ‘Drainage Connectivity” table the HydroID of each boundary lines together with the HydroIDs of the 2 drainage areas it separates.

Note
Drainage Areas with internal pits need to be characterized as such before running this function by setting the attribute “IsPitted” to 1 in the attributes table of the Drainage Area feature class. The Drainage Boundary Characterization tool is using the IsPitted field to indicate whether the drainage boundaries are next to at least one drainage area with a pit. This is important because only this type of boundaries will be processed by the Drainage Connectivity Characterization function. The function
will assume that all input drainage areas have IsPitted = 1 if the field does not exist or if it does not have any records populated with either 0 or 1 (i.e. if the field is not explicitly created and populated, the tool assumes that all areas are pitted).

- Select Terrain Morphology | Drainage Boundary Definition.
- Select Catchment as input Drainage Area layer to process (all drainage areas are processed when there is no selected set).
- Select fil as DEM storing the elevations.
- Keep the default name for the output Drainage Boundary feature class that will store the 3D polylines representing the boundaries.
- Keep the default name for the output Drainage Connectivity table that will store information on the Drainage Areas associated with the new Drainage Boundaries and click OK.

The function performs the following steps:

1. Create the drainage boundaries associated to the selected areas: each boundary line represents the intersection between 2 drainage areas. The Drainage Boundary feature class is a 3D polyline feature class where the elevations are stored in the linear unit of the terrain. It has the following structure:
   - HydroID: unique identifier of the drainage boundary in the geodatabase.
   - MinElev: minimum elevation along the boundary in linear unit.
   - MaxElev: maximum elevation along the boundary in linear unit.
   - IsIncluded: Indicate whether at least one of the two bordering drainage areas has an internal pit (IsPitted=1). Set to 1 in this case. *Note: only the drainage boundaries with IsIncluded=1 will be processed by the Drainage Connectivity Characterization tool.*
   - IsDone: Indicate whether the associated Drainage Boundary has already been processed by the Drainage Connectivity Characterization tool. Populated with 0 by default. Updated to 1 by the Drainage Connectivity Characterization tool. *Note: the Drainage Connectivity Characterization tool will process only Drainage Boundaries having IsDone=0.*
2. Populate the Drainage Connectivity table with information on Drainage areas separated by the boundaries. The table has the following structure:
   - **FeatureID**: HydroID of the associated Drainage Boundary.
   - **FeatureID1**: HydroID of the first drainage area touching the boundary
   - **FeatureID2**: HydroID of the second drainage areas touching the boundary.
   - **ConnectType**: Connection Type. Populated with "Boundary".

The picture below shows that the drainage boundary feature with HydroID 3438 separates the drainage areas with the HydroIDs 3344 and 3334. The highlighted record in the DrainConn shows the same thing: the record with FeatureID 3438 (which is the HydroID of the associated boundary) is located between the drainage areas having HydroIDs equal to FeatureID1 (3344) and FeatureID2 (3334).
3. Drainage Boundary Characterization

The Drainage Boundary Characterization function computes the width, perimeter and cross section area associated with slices of the boundaries of the drainage areas. The function tool works on a selected set of drainage boundary lines, or on all lines if none are selected.

**Note**
Selected lines that have already been processed will be reprocessed only if the checkbox “Overwrite existing characterizations” is checked.

- Select Terrain Morphology | Drainage Boundary Characterization.
- Select DrainageBoundary as input Line 3D feature class storing the 3D polylines representing the boundaries to characterize. The function will extract the elevations from the 3D features.
- Keep the default name, BndEWA, for the output Boundary Elevation Width Area table that will store the characteristics of the boundaries slices.
- Enter 10 (meters) as extrusion value in linear units (optional – default to 0 – no extrusion)
- Specify 3 as the number of slices to create. You could also specify an incremental elevation in linear units to define the slices.
• Leave ZFactor to 1 as the input DrainageBoundary features store the elevations in linear units (meters). You need to specify a ZFactor if the elevations stored in the 3D lines are not in linear units and need to be converted to the linear units by multiplying them with the ZFactor.

• Check “Overwrite existing characterizations” to recharacterize boundaries that have already been processed (otherwise these boundaries will not be reprocessed).

• Click OK.

The function performs the following steps:

1. If “Overwrite existing characterizations” is selected, check whether there are records associated with the drainage areas being currently processed in the output Boundary EWA table. Delete these records.

2. Populate the characterization table Boundary EWA that contains characteristics associated to slices of the boundaries. The table has the following structure:
   • BottomElev: Bottom elevation of the slice in linear unit.
   • TopElev: Top elevation of the slice in linear unit.
   • SlcElev: Mid elevation of the slice in linear unit.
- **SlcWidth**: Width of the water that covers the boundary line for the specified TopElev. Boundary that is exactly at the top elevation is not considered covered and is not included to compute the width, except when the boundary line is flat. In that case, the width is equal to the length of the boundary line.

- **SlcArea**: Area of the cross section of the boundary line that is below the TopElev and above the BottomElev of the slice.

- **CumArea**: Area of the cross section of the boundary line that is below the TopElev.

- **SlcPerimeter**: Wetted perimeter, equal to the sum of the length of the boundary line under the TopElev and the height of the water at the two ends of the boundary line segment.

**Boundary EWA Table**

SlcWidth defines the length of the drainage boundary that is strictly below the top elevation of the current slice. The initial slice is an exception to this rule: the width of the initial slice is the length of the drainage boundary that is exactly at the top elevation of the slice. The highlighted records in the previous table define respectively the initial slice and the top slice (not the extruded slice). The last record in the table defines the optional extruded slice. Note that the width of the extruded slice is the same as the length of the associated drainage boundary, since the entire boundary is located below the top elevation of this slice.
Drainage Boundary Profile

Intermediate slice area, width and perimeter
4. Drainage Connectivity Characterization

The Drainage Connectivity Characterization tool generates connectivity links for drainage areas with internal pits. This function complements the Hydro Network Generation tool that defines the connectivity for dendritic drainage areas. It generates HydroEdges and HydroJunctions. It also generates Boundary Drainage Lines that define links from a pitted drainage area with its neighbors. These lines correspond to the Drainage Lines in a dendritic network.

The function operates on a selected set of Drainage Boundary features or on all features if there are no selected features. Only drainage boundaries associated with pitted drainage areas and that have not been already characterized will be processed (i.e. IsIncluded=1 and IsDone=0).

Note
Make sure that Catchment and Drainage Point are synchronized before starting the process (i.e. the DrainID in the DrainagePoint feature class corresponds to the HydroID in the Drainage Area feature class). For a drainage area with a pit, the DrainagePoint represents the internal pit.

The function will process all features if there is not selected set.

- Select Terrain Morphology | Drainage Connectivity Characterization.

- Select the input DEM (fil), Flow Direction Grid (fdr), Drainage Area layer (Catchment), Drainage boundary (created with the Drainage Boundary Characterization function) and Drainage Point (created with the Drainage Point Processing function) feature classes, and
the Drainage connectivity table (created with the Drainage Boundary Characterization function).

- Keep the default names for the output HydroEdge, HydroJunction and Boundary Drainage Line. Note that the function will create the HydroEdge and HydroJunction feature classes if they have not been already created with the Hydro Network Generation function. However the function will not create the geometric network – this will need to be done manually in ArcCatalog or in the Catalog window in ArcMap.

- Click OK.

The function performs the following steps:

For each selected Drainage Boundary:

- Retrieve the fields HydroID, IsIncluded and IsDone for the Drainage Boundary feature being processed.

- Check whether IsIncluded = 1 and (IsDone = 0 or IsDone is null) for the Drainage Boundary feature. Proceed only if these conditions are met otherwise start processing the next drainage boundary feature.
  
  - IsIncluded = 1 (i.e. borders a pitted drainage area: this field is populated by the function Drainage Boundary Characterization based on the value of the field IsPitted in the Drainage Area feature class. IsIncluded=1 means that at least one of the drainage areas separated by the boundary has an internal pit.)
  
  - IsDone = 0 or null (otherwise already been processed – to reprocess a boundary line, this field needs to be reset to 0 or null)
Note
To reprocess a boundary line you need to reset the attribute IsDone to 0 in the Drainage Boundary table for that feature.

- Retrieve the record associated to this drainage boundary in the Drainage Connectivity table, i.e. FeatureID = HydroID of the Drainage Boundary being processed.

- Identify and retrieve the drainage areas on each side of the boundary.

- Identify the point on the boundary having the lowest elevation. If there is more than one point at that lowest elevation, the function will use the last point found along the drainage boundary.

- Generate the flow path from the lowest point on the boundary into each of the two drainage areas.

- Look for an existing HydroJunction associated with each drainage area. For dendritic drainage areas, the JunctionID field in the catchment feature class is populated with the HydroID of the associated Junction when the Hydro network is generated for the dendritic network. If a HydroJunction is found, move the To-Point of the flow path defined for that area to this HydroJunction. The From-Point for each flow path is the point previously characterized as the lowest point along the boundary.

- If there is no existing HydroJunction, check whether the drainage area has a pit (IsPitted = 1). If it does, look for the associated Drainage Point and make it the To-Point of the flow path.

- Check whether a HydroJunction already exists at the location of the From-Point located on the boundary. If not, create the HydroJunction with the following attributes:
  - HydroID: unique identifier of the feature in the geodatabase.
  - NextDownID: HydroID of the next downstream junction. Set to Null.
  - FType: Boundary Node
  - SchemaRole: 1
  - AncillaryNode: 0 (None)
  - Enabled: 1 (True)
  - JUNCTION_PLACEMENT_DESC: Placement method used for the HydroJunction. Populated with value "AH" – ARCHYDRO.
  - HYDRAULIC_TYPE_DESC: Hydraulic type of the HydroJunction. Populated with value "NO" – NATURAL OVERFLOW.
  - Elev: Elevation at the junction extracted from the boundary line.

- Check whether HydroJunctions already exist at the location of the two To-Points. If not, create the node(s) with the following attributes:
  - HydroID: unique identifier of the feature in the geodatabase.
  - NextDownID: HydroID of the next downstream junction. Set to –1 (no downstream junction) if IsPitted=1 for the corresponding drainage area.
  - FType: Sink Node
  - SchemaRole: 1
  - AncillaryNode: 0 (None)
  - Enabled: 1 (True)
• JUNCTION_PLACEMENT_DESC: Placement method used for the HydroJunction. Populated with value "AH" – ARCHYDRO.
• HYDRAULIC_TYPE_DESC: Hydraulic type of the HydroJunction. Populated with value "STOR" - STORAGE.
• Elev: Elevation at the junction. Populated with Null.

Create HydroEdge of type "Boundary Link" to represent the link in the network. The Hydro Edge will be populated as follows:
• HydroID: unique identifier of the HydroEdge in the geodatabase.
• DrainID: HydroID of the drainage area where the link is located.
• FType: Boundary Link
• FlowDir: 0 (Uninitialized)
• EdgeType: 1 (Flowline)
• Enabled: 1 (True)

Note
The Geometric network itself will not be created by the function if it does not already exists (May be created by Hydro Network Generation). In this case the network needs to be created manually in ArcCatalog.

• Create the Boundary Drainage Line associated to the link. The table has the following structure:
  • LinkID: HydroID of the associated Drainage Boundary.
● DrainID: HydroID of the associated drainage area.
● FType: Feature Type. Populated with "Boundary Link".

Set IsDone = 1 for the Drainage Boundary feature.

Boundary Drainage Line Attributes table

The picture below shows an example of links and nodes created for boundary lines. The Drainage Boundary features that have been processed are displayed in purple. The generated Boundary Drainage Lines are displayed in light green, sink nodes in red and boundary node in green.
- Set the attribute IsDone to 1 in the Drainage Boundary table to indicate that the boundary line feature has been processed.
Global Functions

The tutorial data used in this section is stored in the Data\Global directory.

1. Global Point Delineation

The Global Delineation process uses a combination of geometric network tracing and watershed delineation. The process applies to projects covering big areas (e.g. States). When performing a standard delineation, you are relying on underlying preprocessed catchment and adjoint catchment features, as well as on flow direction and stream grids. The global delineation adds one more level of complexity with the Catalog Unit polygon features (usually Hydrological Unit polygons, e.g. HUC8). To set up the data supporting the global delineation, you need to perform first the terrain preprocessing steps for each individual cataloging unit and to build a geometric network that defines the upstream/downstream connectivity between the cataloging units. The global delineation process is performed as follows:

- Find the current catalog unit feature and perform the standard delineation within that unit using the preprocessed data.
- Trace upstream on the global geometric network to find the upstream catalog units and merge their shape with the local delineated within the cataloging unit.

The preprocessing steps required by this function are described in more details in the document Global Point Delineation with EDNA Data and in the online help. The data used in the tutorial has already been preprocessed and is ready for use with the global functions.

- Open a new map document. Browse to Data\Global\global.mdb and add the feature classes huc_net_Junctions, hucpoly and streams into the map. Save the map document as Global.mxd.
Hucpoly is the catalog unit feature class. Huc_net_Junctions and streams are respectively the junctions and edges in the huc_net geometric network. There is a folder defined for each catalog unit under Data\Global (1111, 2222, etc.). Each folder is named after a cataloging unit and contains the preprocessed data required to perform delineation within that unit.

- Add the Utility Network Analyst toolbar to the map if needed and make sure the results of the traces are shown as selection by selecting Analysis > Options and checking the option Return results as Selection in the Results tab.
• Perform an upstream trace on the network. Select Trace Upstream as Trace Task, click the Add Edge Flag tool and then click on one of the stream features to place the flag. Then click Solve (✓).
Open the attributes table of huc_net_junctions and in the Table Options menu select Related Tables > HUCHasJunction : hucpoly.

The attributes table of hucpoly is displayed and the hucpoly features related to the selected junctions (i.e. the upstream hucs) are selected.
• Clear the flag by selecting Analysis > Clear Flags and clear the selected features.

• Click the Global Delineation tool icon on the Arc Hydro Tools toolbar.

• The tool prompts for the inputs/outputs. Keep the default names and click OK.

The function prompts next for the global data path. This is the parent directory under which the hucpoly subdirectories are located.

• Browse to Data\Global and click OK.
- Click on a streams feature so that an upstream trace at that point will return upstream hucpoly features (i.e. click on the stream in the 4444 hucpoly).

- Select to snap and click OK.

The function then performs the global delineation and shows the result as graphics. You have the option to enter a name/description and save the global watershed or discard it by canceling the operation.
- Enter a name and description for the Global Watershed and click OK.

- Open the attributes tables of GlobalWatershedPoint and GlobalWatershed.

The GlobalWatershedPoint feature class contains the field DrainID which stores the HydroID of the associated GlobalWatershed feature.

The GlobalWatershed feature class contains 2 records as a result of the delineation. The first record with GlobalWshd = 0 is the local delineation within the huc. The second record is the actual GlobalWatershed. Storing the local delineation is required to be able to compute some of the
parameters, which are computed on the fly for the local watershed only and then aggregated with precomputed values stored in the hucpoly features (e.g. Mean elevation as an area weighted average, etc.).

The field RELATEDOIDS stores the OIDs of the upstream hucpoly features for a local watershed, and the OID of the local watershed for a global watershed. The DrainID field stores the HydroID of the associated GlobalWatershed.

- Perform now a delineation within a local huc only by clicking on the map away from the streams features.

You may be prompted whether to snap the point to a stream grid cell if you clicked on a point that is not located on the preprocessed stream grid defined for that huc.

- Select Yes if prompted and then OK. Enter a name/description and click OK to store the GlobalWatershed.

- Open the attributes table of GlobalWatershed and GlobalWatershedPoint if needed.

Note that only one record has been added into the attributes table of GlobalWatershed. It has GlobalWshd = 1 indicating that it is the GlobalWatershed and RELATEDOIDS empty, i.e. there is no related record.
Note
You were not prompted for the names of the input flow direction, catchment, etc. This is because these names are read from the configuration XML and must be the same for all hucpoly. Each subdirectory contains the grids and vector data required to support the local delineation (Catchment, AdjointCatchment, fdr and str).

The name of the directory containing the data for the local delineation is read from the Name field in the hucpoly.
Open the attributes table of hucpoly.

The name field stores the names of the corresponding directories and of the Access geodatabase (.mdb) in those directories.

2. Batch Global Watershed Delineation

This function allows delineating global watersheds for batch points located in Catalog Units. The function performs first a local delineation in the point’s Catalog Unit. It then merges the resulting local watershed with the Catalog Units polygons located upstream. The function also allows computing global parameters by performing operations such as average, weighted average, sum (see list in online help) or by using a custom operator (e.g. 10-85 slope computation). Parameters for global watersheds may also be computed with the function Compute Global Parameters.

The preprocessing steps required by this function are described in the document Global Point Delineation with EDNA Data and in the online help.

Click the Batch tool ( ) and click in each cataloging unit polygon to create a batch point in each one. Call the output Batch Point feature class BatchPointGlobal.
Select Watershed Processing | Batch Global Watershed Delineation.

Select the input Batch Point feature class. Select the Catalog Unit Junction and Edge feature classes, as well as the Catalog Unit Polygon feature class to. Select the output names for the Global Watershed Point and the Global Water. “GlobalWatershedPoint” and “GlobalWatershed” are default name that can be overwritten.

Select the data path to the preprocessed Catalog Units if prompted and click OK.

Click OK.

The function delineates the global watershed for each input point having IsDone<>1 by performing a local delineation in the Catalog Unit where the point is located, and merging the result the Catalog Units polygons located upstream. The output local and global watersheds are stored in the Global...
Watershed feature class. The DrainID field stores the HydroID of the global watershed associated to the record.

The point associated to the global watershed, created by moving the input point to the center of the closest grid cell and snapping it when relevant to the stream grid, is stored in the output Global Watershed Point feature class. The DrainID field stores the HydroID of the associated Global Watershed.

### 3. Compute Global Parameters

This function allows computing characteristics for global watersheds. Some of the characteristics are computed by “merging” characteristics computed on the fly for the local watershed with precomputed characteristics stored in each upstream cataloging unit. For example, the average elevation is computed by averaging the elevation in the local watershed with the averaged elevation in each cataloging unit located upstream of the local watershed. On the other hand, some of the characteristics are computed the same way whether the watershed is local or global and do not need any particular preprocessing (e.g. Y coordinate of centroid, elevation at outlet).

You are first going some characteristics that do not require any global preprocessing.

- Select Attribute Tools > Compute Global Parameters.
Specify the Global Watershed and Cataloging Unit Polygon feature classes as well as the Global Data Path which is the parent directory for all the Global data. Click OK.

The Select Parameters window is displayed.

Select CENTROIDX, CENTROIDY, OUTLETX, OUTLEY, OUTLETELEV and click OK.

After completion, open the attributes table of GlobalWatershed.
The function computes the specified characteristics and stores them into the attributes table of GlobalWatershed.
The function also adds the Centroid feature class into the Table of Contents of ArcMap. This feature class is generated when computing the CENTROIDX and CENTROIDY and stores the Centroid features. The DrainID field stores the HydroID of the corresponding watershed.

You are now going to setup the data so that you can compute the average elevation in feet for the watersheds.

- Select Attribute Tools > Compute Global Parameters. Specify hucpoly as Cataloging Unit Polygon and hucpoly as well as Global Watershed to compute the average elevation for each hucpoly feature. Click OK.
Check the attributes AREA2MI and ELEVFT and click OK. You need to compute AREA2MI as well because it will be used to perform the area weighted average.

The function computes the selected parameters for each hucpoly feature and stores the results in 2 new fields (AREA2MI, ELEVFT) in the attributes table of hucpoly. These values will be used by the function to perform area weighted averages when computing the elevation for global watersheds.
Select Attribute Tools > Compute Global Parameters and select hucpoly as Cataloging Unit and Global Watershed as Global Watershed and click OK.

Select AREA2MI and ELEVFT as parameters to compute and click OK.

The function computes the 2 selected parameters for each watershed and stores them in the attributes table of Global Watershed.

Notes
Refer to the document Local Parameters Configuration.pdf for more information on the parameters.